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Preface

Welcome to the X Server Guide. This guide explains SmarTerm’s X 
Server, Persoft’s enhanced X Window System server that tightly 
integrates X Windows and Microsoft Windows 95/NT operating systems. 
Using SmarTerm’s X Server, users can simultaneously access Windows 95/
NT and network-based UNIX applications on the same PC.

Documentation conventions
This manual has a few conventions:

• Things that you must type appear in a “type-in” font like this: 
type-in font.

• Key combinations appear as key+key. For example, Alt-C means “hold 
down Alt and press C.”

• The book assumes that your mouse is configured for right-handed use. 
“Click” and “double-click” refer to the primary mouse button, which is 
usually the left button.

• “Windows” is a shorthand term for “Windows 95/NT.”

When you see “Start>Programs>SmarTerm folder,” it’s the shorthand 
method that means select the Start button, select the Programs folder, 
and select the SmarTerm folder in which you installed SmarTerm. This is 
an example of the default path suggested by the Setup installation 
program; your exact path to the SmarTerm folder may vary.
ix



Preface
Getting help
If you encounter problems with SmarTerm’s X Server,  check through the 
troubleshooting hints in the SmarTerm documentation. Many situations 
are common and can be corrected easily with the suggestions given there. 
If your problems persist, call Persoft's Technical Support Department for 
assistance (see the back of the title page for this number). We will be glad 
to give you the help you need to get SmarTerm working correctly for you 

Before you call for technical support:

1. Know your license (serial) number. It’s on the Registration card that 
accompanies the software.

2. Be aware that we may need detailed information about your computer, so 
a working knowledge of Windows, the setup of your PC, and the way you 
are using SmarTerm may be necessary.

3. Isolate the problem as much as possible. Does the problem occur every 
time you enter a certain sequence of keystrokes, or do you have to do 
something else first? Writing down a short description of the steps it takes 
to repeat the problem will help both of us to isolate the problem.

Seat yourself at the PC that is giving you trouble and call us from there. 
We may need to have you run one or more diagnostic tests, and these must 
be done on the computer with the problem.
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Installing SmarTerm’s X Server

This section describes the steps you need to take to install SmarTerm’s X 
Server.

Installation requirements
SmarTerm’s X Server runs on any system that has the following hardware 
and software:

• The minimum computer hardware and memory that is required by 
Windows 95 or Windows NT installation on a PC with Intel or 
compatible processors. 

• Windows 95, Windows NT 3.51 or greater installed.

• The Windows 95 or Windows NT TCP/IP stack, if you intend to use the 
Telnet connection method or FTP.

• SmarTerm’s X Server requires 25MB of free disk space for a typical 
installation and up to 56MB to install all components on a PC.

Before you install
Read the following sections to see if there are any steps you need to take 
before running Setup to install SmarTerm’s X Server.
1



Installing SmarTerm’s X Server
Have your license number handy
Setup prompts you for your name, your company name, and your license 
number. The license number is located on the registration card that comes 
with your SmarTerm’s X Server package. Although it is not required for 
installation, Persoft Technical Support will ask you for the license number 
if you call in for help. Entering the license number during Setup prevents 
you from having to remember the number later, when you can’t find your 
registration card.

Shut down extra Windows programs
To make the installation process go as smoothly as possible, shut down 
any programs that may be running in the background such as:

• Applications

• Screen savers other than those shipped with Windows 95 or NT

• Virus protection programs

If you are upgrading from a previous version
If you are upgrading from a previous version of SmarTerm, you should 
first remove the old version from the computer and then install the new 
version. 

To remove previous version of SmarTerm’s X Server:

1. In Windows, select Start>Settings>Control Panel.

2. Double-click Add/Remove Programs.

3. Select SmarTerm X or SmarTerm Enterprise Suite from the list of 
installed applications and click Add/Remove. After a confirmation prompt, 
Windows runs the SmarTerm Setup program with an uninstall script.

➤ This step will also uninstall SmarTerm.

4. Follow the prompts to remove the SmarTerm program files and registry 
entries from your machine. 
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Run Setup
Run Setup
The following section explains basic installation steps. 

1. Insert the CD-ROM into the CD-ROM drive. After a moment, the X Server 
setup will start automatically.

➤ If the CD-ROM “autorun” feature is disabled or unavailable, run 
Launch.exe from the root directory of the CD.

2. Follow the prompts Setup presents to you.

If you don’t like the defaults, select a value from the list boxes on a dialog. 
If you are unsure of the appropriate response to a prompt, consult the 
online help for detailed information about your choices, or accept the 
defaults.
3





Overview

About X
The X Window System (or simply X), originally developed at the 
Massachusetts Institute of Technology, is a portable, network-transparent 
window system.

An X server provides an interface for running X programs (also called 
clients) from a host computer over a network. The X server controls the X 
display, which includes a bitmapped screen, keyboard, and mouse or other 
pointing device. X programs communicate with the server over a network 
using the X Window System protocol.

About SmarTerm’s X Server
SmarTerm’s X Server is an X server ported and enhanced by Persoft to 
operate on IBM-compatible personal computers running Windows 95/NT. 
SmarTerm’s X Server also includes a control panel and a variety of 
utilities and online resources. This chapter describes these components 
and how they fit together.

The starting point for using SmarTerm’s X Server is the X Control Panel 
(also referred to as just the Control Panel), which provides a central 
location for performing all X Server tasks. These tasks include creating X 
program entries, starting X programs, and customizing the X server by 
modifying configuration options. You can also launch SmarTerm’s X 
Server utilities and access online resources from the Control Panel.

To allow X programs to run, SmarTerm’s X Server must be up and running 
on your PC. If the X server isn’t already running, it’s launched 
automatically whenever an X program is started.
5



Overview
This chapter describes the function of the SmarTerm X Server Control 
Panel, the X Server, and other components of the product. Complete 
instructions on starting X programs are found in Program Startup chapter 
starting on page 17. For details on configuring SmarTerm’s X Server, see 
the Configuration Options chapter starting on page 31.

The Control Panel
The SmarTerm X Server program group includes the SmarTerm X Server 
Control Panel icon. To display the X Control Panel, select 
Start>Programs>SmarTerm folder>X Control Panel.         

The Control Panel serves as a starting point for all SmarTerm X Server 
tasks. It provides convenient access to all configuration options, program 
startup, utilities, and online resources.

Once program entries have been created and X program names and/or 
icons appear in the SmarTerm X Server Sessions folder, the Control Panel 
need not be opened each time you wish to run an X program. Instead, you 
can simply click any X program icon to launch the X server and the X 
program.

Because the Control Panel provides quick access to all SmarTerm X 
Server tasks, however, most users want to keep it open throughout each 
SmarTerm X Server session. 

Elements of the Control Panel
The Control Panel’s principal components are the menu bar, toolbar, 
program startup area, and status bar. Each is described in this section.
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Elements of the Control Panel
Menu bar
The Control Panel includes five menus: Program, View, Options, Utilities, 
and Help. Pull down the menu to access the options; alternatively press 
Alt and the first letter of the menu title.

Program menu
This menu is used to manage program entries and exit the Control Panel. 
The Program Startup chapter on page 17 provides detailed descriptions of 
each program management option.

• New—Enables you to create a new program entry based on the selected 
entry in the program startup area.

• Edit—Modifies the properties of the selected entry in the program 
startup area. You may also press Alt-Enter or click the Edit button in 
the program startup area to modify an entry.

• Delete—Deletes the selected entry in the program startup area.

• Run—Starts the program represented by the selected entry in the 
program startup area. 

• Change Icon—Enables you to modify the icon representing the 
selected entry in the SmarTerm X Server Session folder.

• Exit—Closes the SmarTerm X Server Control Panel.
7



Overview
View menu
This menu is used to manage display of various Control Panel elements 
and to determine whether the panel is minimized when other programs 
are started. Each option in this menu toggles on and off; select an 
unchecked option to enable it or a checked option to disable it.

• Minimize On Use—When checked, collapses the Control Panel to a 
button on the taskbar whenever an X program or utility is launched.

• Host—Displays or hides the Host column in the program startup area.

• Toolbar—Displays or hides the toolbar.

Options menu
This menu is used to configure the SmarTerm X Server and X program 
windows. The Configuration Options chapter on page 31 provides detailed 
descriptions of each option.

• Window—Opens the Window Management dialog, allowing you to 
customize commonly-used X window management options.

• Keyboard—Opens the Keyboard Preferences dialog, allowing you to 
customize special key usage and key mapping.

• Mouse—Opens the Mouse Preferences dialog, allowing you to enable 
and customize three-button mouse emulation.

• Font—Opens the Font dialog box, allowing you to select the font used 
to display your client information.
8

 



Elements of the Control Panel
• Configuration—Opens the Configuration dialog box, allowing you to 
customize configuration options not found in the Window Management, 
Keyboard Preferences, or Mouse Preferences dialog boxes.

• Edit RGB Colors—Starts the RGB Color Editor application, which lets 
you create new colors and modify or delete existing colors. See the Color 
chapter for more information.

• Edit X Resources—Starts the Windows Notepad or Wordpad 
application with the XRGB.TXT file. See the Local Resources section in 
this chapter for more information.

Utilities menu
This menu is used to start SmarTerm X Server utilities and the X server.

• Font Manager—Launches the Font Manager utility which allows 
custom X fonts to be converted to the format required by Windows. It 
also manages and allows viewing of font database files and includes a 
font preview feature. For details on this utility, see the Font 
Management chapter starting on page 51.

• X Protocol Trace—Launches the Protocol Trace utility, an advanced 
tool used to monitor communication between the X server and X 
programs. This utility is described in the chapter on X Protocol Trace.

• Performance Tuning—Displays a dialog that lets you choose settings 
that optimize the graphics performance of the X server. When you first 
start up SmarTerm’s X Server, the performance tuning occurs 
automatically and only needs to be rerun if you change graphics cards 
in your PC, install new graphics drivers, or change your system's 
display resolution. This utility is described in detail in the chapter on 
Program Startup.

• X Server—Launches the SmarTerm X Server. Note that the server is 
launched automatically whenever you run an X program.
9



Overview
Help menu
This menu is used to access online resources and to view information 
about the Control Panel. See “Online Help” on page 15 for details on using 
help.

• Contents—Displays the online help contents screen.

• How to Use Help—Displays general information on using online help.

• About SmarTerm X—Displays the Control Panel version number, 
product serial number and version numbers for some shared files.

Toolbar
The toolbar provides quick access to several commonly used menu items. 
The first four icons bring up dialogs accessible through the Options menu.

To view online “pop-up” descriptions of any icon, position the cursor above 
the icon for one second. The following are the toolbar icons:

Window Management

Keyboard Preferences

Mouse Preferences

Font Manager

Help
10

 



X Server
Program startup area
The largest portion of the Control Panel is devoted to program startup:

The Name, Host, and Description column titles are also active buttons. 
Clicking on any one of these buttons will sort the current program entries 
alphabetically by the entries in that column. You can change the width of 
the columns by placing the cursor between the buttons. When the cursor 
changes to a vertical bar, click and drag the cursor left or right to resize 
columns.

The Program Startup Area contains the list of current program entries. 
The example above shows two program entries. Both entries are standard 
X clients, each running on a host called “cabo”.

Below the program entry list are five buttons and an icon. The icon 
reflects how the selected program entry is represented in the SmarTerm X 
Server program group. The buttons allow you to change the icon, create a 
new program entry based on the selected entry, edit or run the selected 
entry, and close the dialog.

X Server
The primary function of SmarTerm’s X Server is to enable X programs to 
run. This requires an X server, a program that communicates with X 
programs through a set of communication standards known as the X 
Window System protocol. 

The SmarTerm X Server is launched automatically whenever an X 
program is started, whether or not the Control Panel is running. In 
addition, you can launch the X Server on its own by selecting X Server 
from the Control Panel’s Utilities menu.
11



Overview
Regardless of how it’s started, a SmarTerm X Server button appears on 
the taskbar once the server is running. (Note that the server behaves 
differently in single-window mode, as described in the chapter on 
Configuration Options.)

By right-clicking on this button, you access the X Server main menu:

Aside from the standard Windows control menu options (Restore, Move, 
Size, Minimize, Maximize, and Close), this menu includes additional 
options:

Close All X Servers
This command terminates all running X servers and the clients running 
on them.

Control Panel
The X Server provides direct access to the SmarTerm X Server Control 
Panel through this menu selection.
12

 



X Server
Copy X Area (Wire Frame Cut & Paste)
This feature allows you to define an area on your display screen and copy 
it to the Clipboard or send it to the printer. You may then paste the 
Clipboard directly into other Microsoft Windows applications, or view the 
Clipboard by selecting Clipboard Viewer. With this option, for example, 
you can bring graphics created by an X program into a Microsoft Windows 
application. Windows NT is limited to bitmaps created by X Windows.

To use this feature, select Copy X Area from the SmarTerm X Server main 
menu. A cross-hair cursor will appear. Move the cursor to the upper left 
point of the area you wish to copy, then click and hold down the mouse 
button as you move the mouse down and to the right to enclose the area. 
Release the mouse button and the defined area will be copied to the 
Clipboard. You may also send this defined area to the default Microsoft 
printer.

Local Resources
You can customize the appearance and operation of many X clients. X 
clients generally are supplied with a default set of variables that are 
contained in a file named Xresources or in some cases the Xdefaults file 
that resides on the host computer. These variables are defined and and 
can be modified by editing the Xresources file or by creating and using a 
local Xresources file. By default this local file is named XRGB.TXT and is 
located in the installation directory. This menu item allows you to Load 
the local file if it exists and control the X client locally. It also allows you to 
Remove the local file that returns control of the X client to the Xresource 
file on the host computer. You may also Edit the local file to change the 
variables controlling the X client. The options and their formats are fully 
described in The X Window User’s Guide by O’Reilly & Associates, Inc. 
Also UNIX® style man pages located on the host machine may contain 
this information for specific X clients.

Edit
This option allows you to copy and paste text blocks between xterms (X 
terminal windows) and the Microsoft Windows Clipboard. You may also 
copy text and send it directly to a Microsoft Windows printer. First, choose 
whether you want to copy to the clipboard or the printer. Then select the 
text in the xterm window. If you wish to paste from the clipboard, pick the 
insertion point in the xterm. The text from the clipboard is placed at the 
insertion point in the xterm.
13



Overview
Enable/Disable Root Window
Many Microsoft compliant applications display a shortcut menu when you 
perform a right mouse click. Many X window managers also display a 
shortcut menu following a right mouse click. This X window manager 
menu is used to move, resize, and change the focus of X client applications 
on your desktop. If you Enable Root Window, you will set your X server to 
override the display of Microsoft shortcut menus. This allows the X 
window manager menu to display which gives you complete control over 
the location, size, and hierarchy of your X clients. If you Disable Root 
window, the Microsoft shortcut menus will function normally.

XServer Info
Select XServer Info from the X Server main menu to get information about 
your SmarTerm X Server session. This includes the display number used 
by this server, the keymap used, the number of client programs supported 
by this server, and monitor information.

About
This command displays the version and serial number of SmarTerm’s X 
Server and the various versions of software that make up the X server, 
including the most currently called DLLs.

Additional components
SmarTerm’s X Server includes a variety of useful utilities, tools, and 
online resources, as shown in this section.

Font Manager
Font Manager allows custom X fonts to be converted to the format 
required by Windows. It also manages and allows viewing of font database 
files and includes a font preview feature. For details on this utility, see the 
Font Management chapter starting on page 51.    

X Protocol Trace
X Protocol Trace is an advanced diagnostic tool that monitors connection 
activity between the SmarTerm X Server and one or more X programs. 
This is often useful for diagnosing and correcting X program problems. For 
details on this utility, see the X Protocol Trace chapter starting on page 59.    
14

 



Additional components
Log File Browser
Log File Browser offers a convenient means of viewing a log file. This file 
contains information on a selected X Server session, including diagnostic 
information whenever a program fails to start correctly. For details on this 
tool, see the X Log File chapter starting on page 77.

Reconfigure
The Reconfigure utility allows you to add or remove fonts and utilities 
from the SmarTerm X  Server without reinstalling the product. It presents 
you a summary of the current installation and lets you make changes. 
Click on this icon to start the utility.

Uninstall
The Uninstall program removes all SmarTerm X Server files and restores 
system files to the state they were in before installation. Click on this icon 
to start the program. Close all X clients and SmarTerm X Server 
applications before running this program.

Keymap Editor
This graphical utility allows you to customize any keyboard for use with 
the SmarTerm X Server. For details on this tool, see the Keymap Editor 
chapter starting on page 69.

Online Help
Help offers a complete context-sensitive online reference for all SmarTerm 
X Server features, functions, and utilities. You can access online help by 
double-clicking the Help icon in the SmarTerm X Server program group, 
by clicking the Help icon or pressing F1 in the Control Panel. You can also 
click the Help button or press F1 in any SmarTerm X Server dialog box.

IM Server
The IM (Input Method) Server application works with the SmarTerm X 
Server and the Windows IM Editor to enable X clients to receive keyboard 
input in double-byte languages: Chinese, Japanese, and Korean. The IM 
Server is launched by the X Server when the X Server is started. The IM 
Server is launched only on systems with the double-byte-enabled versions 
of Windows.
15



Overview
The IM Server sends double-byte data, such as Kanji characters, to X 
clients. Once an X client is running and has the focus (is the active 
window) the process is as follows:

1. The user starts the Windows IM Editor, as required by the specific 
hardware and software environment. For example, you may launch the 
Windows IM Editor with a special key or combination of keys (Alt-~).

2. Keystrokes from the keyboard display in the Windows IM Editor window.

3. When a space is entered, the Windows IM Editor converts to the 
applicable double-byte character.

4. When the Enter key is pressed, the Windows IM Editor transfers the 
double-byte characters to the X server.

5. The X server transfers the characters to the IM Server.

The IM Server uses the IM protocol to transmit the characters to the X 
client running on the host system.

Except for having to enter keystrokes into the Windows IM Editor window, 
the user is not affected by the IM Server.

➤ The IM Server communicates only with X clients that support the IM 
protocol.
16

 



Program Startup

SmarTerm’s X Server simplifies X program startup through the easy-to-
use X Control Panel. In addition, once you have supplied startup 
information and created program entries, you can bypass the X Control 
Panel altogether and start X programs by selecting them from the 
SmarTerm X Server Sessions folder off the Start menu.

This chapter details the program startup process from start to finish and 
provides startup examples.

➤ You can also start programs through the X Display Manager (XDM), 
accessible from the X Control Panel’s Options menu and toolbar. See the  
Configuration Options chapter starting on page 31 for details on this 
startup method.

Creating program entries
Start the Control Panel program by selecting Start > Programs > 
SmarTerm’s X Server > Control Panel.

The first time you launch the Control Panel or if you have deleted all 
existing program entries, the following dialog appears:
17



Program Startup
To run a program, you must first create a program entry for it in the 
Program Properties dialog. A program entry represents all information 
required to run a specified X program. To enter the Program Properties 
dialog, click on the Yes button in the Initial Control Panel.

You can create as many program entries as you wish, representing 
different X programs on any host computer to which you have access over 
a network.

Entering program information
If you already have one or more program entries, click on New in the main 
control panel. This will take you to the following Program Properties 
dialog:
18

 



Creating program entries
You can now enter all information required to run an X program, as 
described below.

Once you save the client information by clicking OK, the values you enter 
become the initial values for future clients you define. The exception is the 
Keymap Selection; its initial option is always Default Keymap.

Name Enter a unique name to represent the X program. This name will appear 
in the Control Panel as well as below the icon created in the SmarTerm X 
Server program group on your desktop. The name cannot contain any of 
the following characters:

,()[]\ / ? *< >:!|"

Description Enter a description of this program entry. This field is optional but useful 
for further identifying each program entry in the Control Panel.

Connection Data This information determines which X program will be run and how it will 
be started. Enter the following data carefully, noting that many fields are 
case-sensitive (upper- and lowercase letters must be typed exactly):

• Host — Enter the name of the host computer on which the X program 
resides. You cannot enter Host if the Connection type is XDMCP 
Broadcast.

• Method — Click the down arrow to select a startup method.  Your 
system administrator can recommend the method to use for your 
installation:

– rexec

– rlogin—does not require a password if the user is already logged on 
to the host. 

– telnet—the best choice if you are having difficulty connecting to the 
host, because more debug information can be displayed. 

– rsh—does not require a password, but the user must be included in 
the rhosts file on the host system. rexec requires a password, but 
does not load a shell

– XDMCP Direct

– XDMCP Indirect

– XDMCP Broadcast

For most users, rexec and rlogin are the best choices. If you choose the 
telnet login method, you can also specify the telnet port to use. Accept the 
default port number, 23, unless your system administrator directs to use 
another value.
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XDM  XDM offers an alternative means of starting X programs. Using XDM 
requires an XDM daemon to be running on the host system. XDM opens 
an xterm client and can be used to execute scripts stored on the host 
computer. You can configure XDM in one of three modes. The three XDM 
connection methods are

• Direct — In direct mode, a SmarTerm X Server sends an XDM request 
to a specific host computer. Enter the host’s Internet name or IP 
address.

• Indirect — In indirect mode, the X Server sends an XDM request to a 
single intermediate host, with the expectation that this host will 
forward the request to a number of secondary managers on different 
hosts. XDM will then run on the first secondary host to respond. The 
intermediate host may also accept the request. 

Enter the intermediate host’s Internet name or IP address. Note: This 
mode may require special host configuration. Consult your system 
administrator for assistance.

• Broadcast — In broadcast mode, the X Server sends an XDM request 
to all hosts on the same network (broadcasts only within a subnet). 
Some hosts will respond, while those that do not wish to service the 
request will ignore the broadcast. To run XDM on the first host that 
responds, select the Select First Responding Host option. Otherwise, 
you will be presented with a list of all responding hosts. You may then 
select the host on which to run XDM.

Click Custom only if you need to modify the advanced parameters in the 
Custom Startup Data dialog box. Most users do not need to do so. You 
cannot use the Custom feature if the Connection type is XDMCP Direct, 
XDMCP Indirect, or XDMCP Broadcast.

• User Name — Enter the user name for your account on the host 
computer, as you would during any session with this X program. If you 
need assistance, consult your system administrator. You cannot enter a 
User Name if the Connection type is XDMCP Direct, XDMCP Indirect, 
or XDMCP Broadcast.

➤ If you leave this field blank, you will be prompted to enter your user name 
each time you start the program. This protects against unauthorized use 
of the program through your account.

• Password — Enter the password for your account on the host 
computer, as you would during any session with this X program. If you 
need assistance, consult your system administrator. You cannot enter a 
password if the Connection type is XDMCP Direct, XDMCP Indirect, or 
XDMCP Broadcast.
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➤ If you leave this field blank, you may be prompted to enter your password 
each time you start the program, depending on the password options you 
select (see below). This protects against unauthorized use of the program 
through your account.

• Password Options —Select the type of password security you require. 
You cannot choose Password Options if the Connection type is XDMCP 
Direct, XDMCP Indirect, or XDMCP Broadcast.

Choose Always Use Saved Password (default) to use the password 
you have provided every time you run the program.

Choose Prompt for First Program Only to require a password to be 
entered for the first X program run during a SmarTerm X Server 
session, but not for subsequent programs run during the same session. 
This level of security is often sufficient and does not require a password 
to be entered for each program. You can change your user name as well 
as entering a password.

Choose Prompt for Each Program to require a password to be 
entered for every X program. You can change your user name as well as 
entering a password. This provides maximum security.

• Command — Enter the X program command string to be executed on 
the host computer. You cannot enter a command if the Connection type 
is XDMCP Direct, XDMCP Indirect, or XDMCP Broadcast.

The following example is a command for the popular X terminal emulation 
program xterm:

nohup /usr/bin/X11/xterm -display $DISPLAY &

where

nohup is the UNIX command that prevents program termination;

/usr/bin/X11/xterm is the full path to the xterm program (you may omit 
the path if it is included in your PATH environment variable on the host 
computer);

-display indicates that the next string is the destination display;

$DISPLAY directs output to your local PC;

& executes the program in background mode, generally the preferred 
operation mode.
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Custom Startup Data Next to the User Name entry in the Connection Data area is the Custom 
button. Click this only if you need to modify one of the parameters in the 
Custom Startup Data dialog box:

These parameters are:

• Response Window Close — When enabled, the connection response 
window will normally remain open until closed by the user. This is its 
behavior when the default Response Window Close setting (Never) is 
selected. If you wish the window to close automatically after a set 
interval, select the After option and enter the number of seconds it 
should remain open.

• Connection Timeout — The interval (in seconds) during which the X 
server will attempt to connect to the host. If no connection is established 
during that interval, the server will return a message indicating a 
timeout error. The default interval of 30 seconds will suffice in most 
situations, but you may change the value to any number between 1 and 
600.

• User Prompt — When the telnet startup method is used, the 
SmarTerm X Server will wait for this prompt before sending the user 
name. The UNIX default (“ogin:”) consists of the last four letters of 
“login” plus the colon. Do not modify this unless telnet will not function 
because the prompt cannot be found. For VMS highlight the field and 
change it to (“sername:”) which is short for “username.”
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• Password Prompt —When the rlogin and telnet startup methods are 
used, the SmarTerm X Server will wait for this prompt before sending 
the password. The default (“ssword:”) consists of the last six letters of 
“password” plus the colon. Do not modify this unless rlogin or telnet will 
not function because the prompt cannot be found.

You cannot specify the custom parameters if the Connection type is 
XDMCP Direct, XDMCP Indirect, or XDMCP Broadcast.

Feedback The two options in this area provide feedback when the program is 
launched. You cannot select feedback options if the Connection type is 
XDMCP Direct, XDMCP Indirect, or XDMCP Broadcast.

• Show Status Window — Displays a window showing the progress of 
the startup method you have selected, as shown below. This option is 
enabled by default.

• Show Response Window — Displays a window showing the 
connection response during program startup. The window includes 
startup information, such as job number and process number, as shown 
below. This option is disabled by default.

Keymap Selection A keyboard map must be defined for each client. You can use either the  
Default Keymap or assign a specific keymap file. When you select the 
Client Specific Keymap option, the Select Client Keymap button is 
enabled. Click Select Client Keymap and then choose the keymap file to 
associate with the client you are defining or editing.
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➤ Assigning a client specific keymap forces the X Server to launch a new 
X server to run this client, even if other clients use the same keymap. So, 
you should define the default keyboard to be the keyboard that most of 
your clients use. Assign the default keymap from the Control Panel by 
choosing the Keyboard Command on the Options menu. If no default 
keymap has been set, a U.S. English keyboard map is assumed.

If you edit a client with a client-specific keymap and that keymap file has 
been deleted or renamed, an error message appears indicating that 
SmarTerm X Server cannot find the keymap specified.

You must select an existing keymap file or choose the Default Keymap to 
save the client program.

Testing a program entry
After entering data in the Program Properties dialog box, you may wish to 
run the program immediately to ensure you have entered all information 
correctly. It is usually best to enable the Show Status Window and Show 
Response Window options to provide maximum feedback, even if you later 
decide to disable these options before saving the program entry.

Click Test at the bottom of the dialog box to run the program. If you have 
omitted any required information, you will be advised to provide it. 
Otherwise, the status and response windows will appear and the 
X program should run properly. (If it does not, the response window may 
provide helpful troubleshooting information.)

Once the X program window appears, exit it to return to the Program 
Properties dialog box. You may wish to disable either or both of the 
feedback options at this time.

Saving a program entry and creating an icon
Once you are satisfied with the program entry, click OK from the Program 
Properties dialog box. 

➤ The icon at the bottom of the Control Panel appears in the SmarTerm X 
Server program group along with the name of the program entry. If you 
wish to change this icon, click the Change Icon button (you can also select 
Change Icon from the Program menu or press Ctrl-I).

Icons provided with the X Server appear under Current Icon. Scroll 
through the icons and select one you like. Alternatively, you can access 
additional icons by entering a different source file under File Name, or by 
clicking Browse to locate an icon.
24

 



Running programs
Once you have selected an icon, click OK. The icon will appear in the 
Control Panel and also in the SmarTerm X program group accessible from 
the Start - Programs menu.

Running programs
Once you have created a program entry, you can run it from the Control 
Panel by:

• Double-clicking the entry

• Clicking the entry once and pressing Enter.

• Clicking the entry once and clicking the Run button

• Clicking the entry once and choosing the Run command from the 
Program menu

You can also run the program directly by selecting the menu item in the 
SmarTerm X Server program group accessible from the Start>Programs 
menu. You do not need to open the Control Panel before doing so.

From the Control Panel you can initiate multiple clients simultaneously. 
Hold down the shift key while dragging the mouse to highlight the 
X clients, then click on Run.

Modifying program entries
You can modify a program entry at any time. To do so, click the entry once 
in the Control Panel, then click the Edit button (you can also select Edit 
from the Program menu or press Alt-Enter). This will cause the Program 
Properties dialog box to appear.

Modify any of the program entry information you wish. When finished, 
click OK to save your modifications, click Test to verify that the program 
runs properly, or click Cancel to void your changes.

If you have changed the name, host name, or description, these changes 
will be reflected in the Control Panel. If you have changed the name, or if 
you subsequently change the icon, these modifications will also be 
reflected in the SmarTerm X Server program group.

Program entry example: xterm
This section presents three examples of program entries with different 
startup data.
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Example 1: xterm    

In this example, the user will be starting an xterm on the remote host 
computer “cabo.” The user has provided a user name (dpb) and password, 
and the Prompt for First Program Only option has been selected. 

The startup command includes the full path to the xterm program and 
indicates a display name of “$display,” indicating the Internet name of the 
PC will be found in the DISPLAY environment variable on the host.

The status window has been enabled to indicate progress of the startup 
command.
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The default keyboard will be used with this client. To view the current 
default keyboard, use the Keymap Editor application and open the .KMP 
file.

Example 2: xclock

In this example, the user will be starting an xclock on the remote host 
computer “miami.” The user has provided a user name (dpb) and a 
password, which will be used automatically each time this program is 
started.

This startup command does not include a full path to the program, 
indicating either that the program can be found in the user’s home 
directory on the host, or that the path to the program is included in the 
user’s PATH environment variable. The xclock program will be directed to 
the user’s PC.
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The response window has been enabled so that the user can view startup 
communication from the host computer.

The application uses the keymap defined in the file ITALIAN.KMP.

➤ Because a specific keymap has been specified, this client will cause a new 
instance of the X server to be launched unless there is already a running 
X server that uses the same keymap file and does not use an XDMCP 
login method.

Example 3: xclipboard

In this example, the user will be starting an xclipboard on the remote host 
computer “brent.” The user has provided a user name (dpb) and a 
password, but has selected the Prompt for Each Program option. This 
indicates that the user will need to enter the password each time this 
program is run.
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Program entry example: xterm
The startup command includes the full path to the xclipboard program 
and indicates a display name of “$display,” indicating the Internet name of 
the PC will be found in the DISPLAY environment variable on the host. 

The program will use the Default Keymap.
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Configuration Options

SmarTerm’s X Server includes a variety of configuration options that 
allow each user to customize the operation of the X Server and all X 
programs. While in most cases the default values for these options yield 
excellent results, many users want to explore these options to enhance the 
operation of SmarTerm’s X Server on their systems.

This chapter describes all configuration options and how they can be 
modified through the SmarTerm’s X Server Control Panel. Default values 
and special considerations, such as whether or not an X Server restart is 
required for the option to take effect, are indicated throughout.

Accessing configuration options
The SmarTerm X Server Control Panel provides access to all configuration 
options. Select Options>Configuration from the Control Panel.    

All configuration options are accessible through the Options menu:

The Window Management, Keyboard, and Mouse commands are 
represented with icons on the Control Panel toolbar as well. Each of these 
options is described in detail in this chapter.
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Several options are available from the Configuration command. These 
options are detailed in this chapter.

The Edit RGB Colors command allows you to open the graphical Color 
Editor utility. This is described in detail in the Color chapter.

The Edit X Resources command is described at the end of this chapter.

Window Management dialog
Select Options>Window from the X Control Panel, or click the Window 
Management icon in the Control Panel toolbar, to display the Window 
Management dialog:          

Window Management options allow you to customize the window mode, 
mouse panning, and other elements relating to the look and feel of your X 
program windows.
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Window Mode
This option has the most visible effect on how the X Server operates. Most 
users prefer multiple-window mode, which enables X windows to be 
handled individually, just like standard Windows application windows. 
Other users prefer single-window mode, in which all X windows are 
included within a single root window, similar to the display of standard X 
terminals.

In multiple-window mode (the default), each X program is displayed in its 
own window. These windows are managed either by Windows or by any X 
window manager that’s invoked. In the following figure, the two xterms 
running appear in their own windows on the desktop. They are controlled 
by Windows.

In single-window mode, all X programs are displayed within one window, 
called the root window. An X window manager must be invoked to manage 
the X windows within the root window. 

Motif Window Manager is controlling the two xterm windows. In this 
mode, the X Server’s main menu is accessed by clicking the root window’s 
control menu (at the upper far left corner of title bar):
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One additional difference between the two window modes involves how 
the X Server behaves when windows are closed. In multiple-window mode, 
closing an X window doesn’t necessarily end the X Server session, unless 
Exit After Last Program has been enabled (see “Exit After Last Program” 
on page 40). In single-window mode, closing the root window 
automatically closes all X programs and terminates the X Server session.

Multiple-window mode options
Four options in the Window Management dialog are available for 
multiple-window mode operation:

Mouse Panning Allows automatic panning (scrolling) of X windows in multiple-window 
mode. If an edge of an X window doesn’t appear on screen, this option 
enables you to bring it into view by moving your mouse toward the 
invisible edge. This slides the window in the opposite direction until the 
edge appears.

This option is disabled by default.

➤ The Focus Policy option must be set to MS Windows for panning to 
function (see “Focus Policy” on page 38). Also, a window doesn’t pan if it’s 
not the active window or if a mouse key is depressed while the mouse is 
moved.

Cascade Windows Uses Cascade X feature to position new X windows automatically such 
that they don’t completely obscure existing windows. 

This option is enabled by default.

➤ Some X programs proscribe specific display locations (geometry) in their 
startup files. This information is overridden when Cascade Windows is 
enabled.

Fit Window to Display Restricts the size of each X window to your maximum screen size. Disable 
this option to allow X windows to be wider and taller than your screen.

This option is disabled by default.

Force Window on
Screen

Forces all X program windows to appear on your display, even when they 
would normally appear off screen. Disable this option to maintain the 
original position of new X windows.

This option is disabled by default.

Single-window mode options
Two options in the Window Management dialog are available for single-
window mode operation:
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Mouse Panning Allows automatic panning (scrolling) of the root window. This enables you 
to navigate throughout a root window that’s larger than your display by 
moving your mouse toward any edge of the window. The window pans 
whenever the mouse is within a narrow strip inside each edge or below the 
title bar. (Panning doesn’t occur if a mouse key is depressed while the 
mouse is moved.)

This option is disabled by default.

Scroll Bars Causes scroll bars to appear along the right and bottom edges of the 
screen. This provides a clear indicator of your current location relative to 
the X root window at all times. This feature is especially useful when the 
Mouse Panning (see the previous option) or Virtual Screen (see “Virtual 
Screen Width and Virtual Screen Height” on page 38) options are in effect.

This option is disabled by default.

Keyboard Preferences dialog
SmarTerm X Server provides an easy-to-use graphical keymap editor that 
allows you to customize any keyboard for use with the X server. Choose 
the Keyboard command from the Control Panel Options menu, or click the 
Keyboard Preferences icon in the Control Panel toolbar, to display the 
Keymap Editor. This utility is described in the Keymap Editor chapter.

➤ The Keyboard command is not listed in the Control Panel Options menu if 
the X Server was installed from a file server.
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Mouse Preferences dialog
Select Options>Mouse from the X Control Panel, or click the Mouse 
Preferences icon in the Control Panel toolbar, to display the Mouse 
Preferences dialog:            

This dialog allows you to enable or disable middle-button emulation. Since 
many users have a two-button mouse, and since many X programs require 
the middle button of a three-button mouse, this feature saves many users 
from having to purchase a new mouse to use certain X programs.

With Emulate Middle Button selected, you can click the left and right 
buttons simultaneously to create the effect of a middle-button click.

You can customize the interval during which clicks of the left and right 
buttons are interpreted as a middle-button click. Move the button along 
the slider bar between its shortest value (.001 second) and its longest (1 
second).

By making the interval very short, you need to click the buttons at almost 
exactly the same time to achieve a middle-button click; if you don’t click 
both buttons within the interval, the two clicks are interpreted 
individually.

By lengthening the interval, you extend the window of time during which 
the clicks are interpreted as a single middle click. However, all mouse 
clicks require more time to take effect.
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You can test these changes by clicking the left and right mouse buttons 
separately and together within the test area. The effect of your actions are 
reflected on the test mouse.

Middle-button emulation is enabled by default. Unless your X program 
requires simultaneous left and right mouse button clicks, you probably 
don’t need to disable this option. The default emulation interval is three-
quarters of a second.

Configuration dialog
Select Options>Configuration from the X Control Panel to display the 
Configuration dialog:     

This comprehensive dialog allows you to customize all configuration 
options not available through the Window Management, Keyboard 
Preferences, Mouse Preferences, and X Display Manager dialogs. For this 
reason, you should become familiar with the contents of those dialogs 
before modifying options within the Configuration dialog.

Six option categories (tab dialogs) are presented in this dialog: Window, 
Server, Graphics, Fonts, Performance, and General.

Window
All configuration options relating to the look and feel of X windows that 
aren’t found in the Window Management dialog are included in this 
category.
37



Configuration Options
Concurrent Window Manager
When On (the default) is selected, it enables an X window manager to 
control X windows while Microsoft Windows controls other windows; Off 
disables this feature, allowing only Microsoft Windows to control X 
windows.

Generally, this option should be enabled so that an X window manager can 
operate concurrently with Microsoft Windows in multiple-window mode. 
However, in some situations you might want to disable this feature so that 
no X window manager can be started.

This option applies to multiple-window mode only.

Focus Policy
Choose MS Windows (the default) to allow keystrokes to be directed only 
to the active window, per the standard Microsoft Windows mode of 
operation. Choose X to allow keystrokes to be directed to the window 
under the cursor, regardless of which X window is active, per the standard 
X Window System mode of operation.

This option applies only when X windows are managed by the Microsoft 
window manager, which is the case only in multiple-window mode.

Motif Properties
In multiple-window mode, the On selection mimics Motif Window 
Manager properties (hints) when Microsoft Windows is controlling all 
windows (that is, when no X window manager is running); Off (the 
default) disables this feature.

Display Number Visible
“On” (default) causes the number of the display used by a client to be 
displayed in the client’s title bar after the client name and in the Taskbar 
(Windows 95, Window NT).

Screen Dimensions
The X Server receives display size information from your PC’s video 
driver. If you find that your X windows are either too large or too small, 
use this option to enter your display dimensions (in millimeters). This will 
accurately inform the X Server of your display capabilities.

Virtual Screen Width and Virtual Screen Height
In single-window mode, X programs that require a display resolution 
higher than that allowed by your display hardware can take advantage of 
the virtual screen feature. 
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Using this option, you can define the resolution of the root window to 
exceed the physical resolution of your display device, up to a maximum of 
32,767 x 32,767 pixels. This virtual screen capability lets you run X 
programs that require screen sizes greater than your display size. Scroll 
bars, if required, are automatically added to the X root window to allow 
you to scroll to areas of the virtual screen that would not otherwise be 
accessible on your display.

To use this option, enter a virtual screen width and height in pixels (up to 
32,767 each).

Server
All configuration options relating exclusively to operation of the X Server 
are included in this category.

Clipboard Link
Specifies the X copy buffer to be linked to the Microsoft Windows 
Clipboard. Choose PRIMARY (the default) unless you’re running an X 
program that requires another X copy buffer.

An advantage of running applications under Microsoft Windows is the 
ability to copy and paste information from one application to another. The 
Clipboard is a temporary storage location that can always be used to 
transfer information during a Windows session.

The X Window System offers even more comprehensive Clipboard 
functions. SmarTerm’s X Server extends the capability of the Windows 
Clipboard to allow X programs to deposit and retrieve both text and 
bitmapped graphics. You can cut or copy information from a Windows or X 
program to the Clipboard and then transfer the data to any application.

To examine the contents of the Clipboard, use the Clipboard Viewer. Note 
that once you copy an item to the Clipboard, previously stored items are 
overwritten. To allow later retrieval of Clipboard items, save each item to 
a file.

Clipboard Management
When On (the default) is selected, it allows only the server to manage the 
X clipboard; Off allows an X program to manage the X clipboard instead.

Choose On unless you’re running a program to manage the X clipboard.
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Disable Restart
When On is selected, it prevents recycling of the X server, even when 
recycling is required to complete a configuration change. This prevents the 
server from automatically resetting when the last X program is closed. 
This might be of value if you wish to preserve environment settings of the 
host machine. 

Off (the default) allows the server to be recycled. Choose Off in most 
situations.

Exit After Last Program
When On is selected, it exits the X server once the last X program has 
closed. Off (the default) keeps the server running after all programs have 
closed.

Prompt for Program Close
When On (the default) is selected, it directs the X Server to display a 
confirmation dialog whenever you close an X program window; Off 
disables this feature. The dialog gives you the option to confirm the action, 
thereby terminating the X program, or cancel and return to the X 
program. (This dialog might not appear if the X program performs its own 
close.)

Prompt for Server Exit
When On (the default) is selected, it enables a dialog to be presented 
should you attempt to end your X Server session while an X program is 
still running. You can then choose to cancel the operation and close the 
active program normally. You should close programs as documented before 
shutting down the X Server to prevent random processes from lingering 
on the host and to save data properly before closing system files.

Off disables this feature, thereby closing all X programs automatically if 
they are still running when you exit the server.

R3 Bug Compatibility
When On (the default) is selected, it enables certain X11R3 programs to 
run with the X Server. This allows certain minor errors to be self-
correcting or ignored, thereby permitting X11R3 applications to function 
correctly.

Choose On unless you’re running an X11R3 program that requires this 
compatibility to be disabled.
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Server Display Control
When On is selected, it prevents all X and Windows applications from 
interrupting an X program that requires control of the display. This 
ensures that the X program has access to the full resources of both the X 
Window System and Microsoft Windows. Select this option to prevent 
display-intensive applications from being interrupted by system message 
dialogs. 

Off (the default) disables this feature. Choose Off unless you’re running an 
X program that requires complete display control.

Graphics
All configuration options relating to screen colors and other aspects of how 
graphics are displayed in X windows are included in this category.

Change White Pixel
When On is selected, it changes the RGB value of white from 255 to 1. Off 
(default) maintains the normal value of 255.

Choose On only if you’re running X programs that require white to be 
defined as 1.

Color Database File
Specifies the full path and name of this file. The default file name is 
RGB.TXT, located in the SmarTerm program folder. If no path is 
indicated, the SmarTerm program folder is assumed. 

The color database file is used by the X Window System to simplify color 
specification and promote color sharing. For more information on this file, 
see the Color chapter starting on page 79.

Modify Color Cursors
Some cursors might not be visible on certain backgrounds. Choose On to 
make such cursors visible in these situations. Note that this changes the 
appearance of all color cursors, so this feature should be enabled only in 
special circumstances.

Off (default) causes cursors to appear normally.

This option goes into effect after the next program is launched.
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Preallocate Colors
The Always value informs X programs that they have access to 256 colors, 
even though some of these colors cannot actually be used. When Restrict 
(the default) is selected, it limits the reallocation of reserved system 
colors.

Normally on a 256-color display, the X Server provides X programs with 
access to only 236 or 254 colors, depending on whether the Reserve 
System Colors option is enabled (see the next section). This is usually not 
a problem, since most X programs don’t require the 2 or 20 restricted 
colors that are unavailable. 

However, some X programs refuse to run unless they believe they have 
access to the full 256-color palette. Enable this option to run such 
programs. Since the fact remains that X programs cannot change the 
colors reserved by Microsoft Windows, some of the colors used by these 
programs might not appear correctly. Nevertheless, the program runs 
properly with this option enabled.

Reserve System Colors
When On (the default) is selected, enables SmarTerm’s X Server’s Color 
Map Reservation System (CMRS©) to protect 18 of the 20 static colors of 
the default Microsoft Windows color palette. This protects the ability of 
Microsoft Windows to match color requests, leaving X programs with 
access to 236 (rather than 254) colors.

Selecting Off disables this protection, making the 18 Windows system 
palette colors available to X programs, thereby giving them access to 254 
colors. This leaves Windows with only two static colors with which to 
match color requests.

This option is enabled by default and should remain enabled unless you’re 
running an X program that requires access to the 18 static colors. If your 
display hardware or selected screen visual doesn’t support Microsoft 
Windows palettes, this option isn’t available.

Screen Visual
SmarTerm X supports four colormap options (TrueColor, PseudoColor, 
GrayScale, and StaticGray) in addition to the X Window System 
StaticColor model. This option enables you to choose the color model your 
monitor will use. Only the color models supported by your display 
hardware will be presented.

The color models available are:
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• PseudoColor — This is the most versatile screen visual class and is 
supported on displays with changeable hardware colormaps (color 
displays that support Microsoft Windows palettes). With this option 
selected, X applications can define and select the maximum number of 
colors supported by the display (256 for a screen depth of 8 bits).

• GrayScale — Like PseudoColor, GrayScale requires a display device 
with a changeable hardware colormap. With this option selected, 
X applications will attempt to map colors into shades of gray that 
provide adequate contrast. (The number of shades that can be displayed 
simultaneously depends on your display hardware.)

• TrueColor—This screen visual class is supported only on displays with 
16- or 24-bit color capability. With this option selected, X applications 
can select 32,768 colors for 16-bit cards, 16.8 million colors for 24-bit 
cards.

• PseudoColor—This is the most versatile screen visual class and is 
supported on displays with changeable hardware colormaps (color 
displays that support Microsoft Windows palettes). With this option 
selected, X applications can define and select the maximum number of 
colors supported by the display (256 for a screen depth of 8 bits).

• GrayScale—Like PseudoColor, GrayScale requires a display device 
with a changeable hardware colormap. With this option selected, X 
applications attempt to map colors into shades of gray that provide 
adequate contrast. (The number of shades that can be displayed 
simultaneously depends on your display hardware.)

• StaticColor—This screen visual is used for displays with an 
unchangeable hardware colormap, such as standard VGA monitors. 
With this option selected, X applications map each color request to the 
closest available color.

• StaticGray—StaticGray is used for displays with an unchangeable 
hardware colormap, such as black-and-white monochrome monitors. 
These displays feature a single-plane screen with a two-element read-
only colormap. With this option selected, X applications map each color 
request to either black or white.

If you are not sure which option to select, choose the default selection.

If you’re not sure which option to select, choose the default selection.

For complete details on color issues, see the Color chapter starting on page 
79.
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32-bit TrueColor Images
The On option (default) ensures display of X Server graphic information 
between X clients and the server at 32-bits per pixel. This information is 
exchanged and displayed regardless of the pixel depth of your PC’s display 
configuration. Toggling this option On ensures the correct display of 
Common Desktop Environments (CDE) such as Solaris, HP, and others. If 
your display appears normal without this option, you may save some 
system overhead by toggling it Off.

Fonts
All configuration options relating to fonts used by the SmarTerm X Server 
are included in this category.

Default Font
Specifies the font to be used by any X program that doesn’t specify its own 
font. This font may not be used by X programs that specify their own fonts. 
The default entry is fixed, which represents the 6X13.FON font file.

Font Path
Specifies all folders in which X fonts are located. By default this is set to 
the font folders within the SmarTerm program folder.

You can add or delete folders as needed. Include the full path to each 
folder. Use commas to separate entries.

Alternate Font Path
Specifies font directories in addition to the standard font path. This path 
is searched if fonts cannot be located in the standard font path.

Match to Windows Font
When On (the default) is selected, it matches an X program font request 
with the most similar Microsoft Windows font available, if the requested 
font cannot be found. This ensures that all font requests are satisfied.

Selecting Off disables this feature, causing an error to be returned if a 
requested X font cannot be found.

Choose On in most situations.
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Temporary Font Path
This option is used in conjunction with the font server capability. If you’re 
using fonts from a network font server, the most recently used fonts are 
downloaded and stored in the location specified by this option for quick 
access without constant network traffic.

The default entry is a folder within the fonts folder. The name of this 
folder is 00000000 or your PC’s IP address in hexadecimal format (for 
example, C009C818).

To change this location, enter a full path name to a folder in which font 
server fonts are stored, as in the following example:

C:\USER\MYNAME\TEMPFONT

The folder specified is automatically created if it did not previously exist.

Performance
All configuration options relating to X Server performance are included in 
this category.

Backing store
Backing store is the ability of an X server to retain the contents of 
unmapped windows and windows that are partially or totally obscured by 
other windows. By re-drawing the contents of such windows, the X Server 
avoids expose events and thus avoids generating the network traffic 
required to send information to repaint the window. However, because the 
backing store increases the amount of memory required by the server, this 
option isn’t recommended for users with a limited amount of memory.

The three backing store options are:

• Off (default)—Disables backing store.

• On When Requested—Enables backing store only for X programs that 
request it.

• Always On—Forces backing store to be used for all X programs.

Fast line drawing
When On (the default) is selected, it allows the server to draw width-one 
lines and certain dashed lines using Microsoft Windows drawing 
algorithms. These algorithms allow faster performance but don’t meet X 
drawing specifications.

Selecting Off disables this option, which you should choose if you require 
pixel-perfect drawing.
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Plane mask
When On (the default) is selected, it allows plane masks to be used by X 
programs. Selecting Off disables this feature.

The color of each screen pixel is represented by a certain number of bits 
(for example, eight), each of which may have the value 0 or 1. X 
applications may allow graphics operations to be configured to ignore 
(mask) information in one or more of these eight bits. If a plane mask is 
established on bit 8, for example, then only information in bits 1 through 7 
are transferred from source to destination during a graphics operation, 
leaving bit 8 with its original value on the destination.

Most X programs that use plane masks in graphics operations do so 
correctly. For these applications, enabling the plane mask option yields the 
best results.

However, some X programs might use the plane mask incorrectly, 
resulting in unusual screen colors when this option is enabled. If you’re 
running such an X program, disable this option to prevent the program’s 
use of the plane mask. This might result in faster operation.

Resource usage
The more resources allotted to the X server, the better its performance but 
the fewer resources available to other Windows applications. Customize 
your server’s performance by choosing the amount of resources it uses. 
Choose the Minimum Resources, Some Resources, More Resources, or 
Maximum Resources (the default) option. The default setting enables the 
best performance.

To see how much of your system resources are being used at any time, 
select Start>Settings>Control Panel and click the System 
icon>Performance tab. System resource information appears on the 
resulting dialog.

Save unders
This option is similar to Backing Store except that it saves only what is 
covered by a window or menu, rather than the contents of all partially or 
totally obscured windows. Save Unders is used primarily with pop-up 
menus to save the information covered temporarily by the menus. This 
decreases network traffic when windows are repositioned on the display.

This option applies only if Backing Store is set to On When Requested or 
Always On.

Save Unders is disabled by default.
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Batch request
When On (the default) is selected, it allows the X server to combine 
multiple requests for faster performance when possible. Selecting Off 
disables this feature.

Jump scroll
When On (the default) is selected, it allows the X server to combine 
scrolling operations for faster performance. Scrolling occurs when a 
terminal emulation program moves text up or down in a window. Selecting 
Off disables this feature.

General
All remaining configuration options can be found in this category.

Display Number
This option allows you to change the default X server display port number, 
if required. Normal operation sets this value to 0. This is reflected in a 
startup command of the following format:

xterm -display pc_name:0

where pc_name is the Internet name (or IP address) of your PC. If for 
some reason your display number is other than 0, enter the valid display 
number to inform the SmarTerm X Server.

IPX/SPX Name
Specifies the Internet name of your PC for use with IPX/SPX network 
software.

Network Type
Specifies the type of network you’re using: Windows Socket Library 
(Winsock) or IPX. This is set during installation and generally should not 
be modified.
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Local Host Access Control
You can control host access to your X display locally through this 
mechanism. Local Host Access Control is either Enabled or Disabled. 
When Access Control is Disabled, all hosts on the network are able to send 
X programs to your display; there is no access control. If you do not want 
your display interrupted by network host messages or clients, you may 
Enable Access Control. When you select the Local Host Access Control 
option and Enable it for the first time, you will be prompted to edit the 
host file. Create this file by entering the network names of hosts you want 
the X server to accept connections from. Any network host not listed will 
not be able to contact your X server display. Name and save this file and it 
will automatically be given the .HST extension. The contents of this file 
will be written to the HOSTS file each time you Enable the Local Host 
Access Control option.

You may create multiple access control files containing different lists of 
hosts you allow to connect to your X server. The last .HST file you open is 
the active access control file. This file’s contents are written to the HOSTS 
file when you Enable the Local Host Access Control option.

X Resource File
You can customize the appearance and operation of many X clients. 
X clients generally are supplied with a default set of variables that are 
contained in a file named Xresources or in some cases the Xdefaults file. 
These variables are defined and and can be modified by editing the 
Xresources file or by creating and using a local Xresources file. The 
X Resource File option lets you specify the location of your custom 
Xresources file on your local system. Simply enter the drive name, 
directory path, and filename of your Xresources file. The default Xresource 
file is named XRGB.TXT and is located in the installation directory.

The options and their formats are fully described in The X Window 
User’s Guide by O’Reilly & Associates, Inc. Also UNIX style man pages 
located on the host machine may contain this information for specific 
X clients. 

Load Local X Resource
This option has two states: Yes and No. If you toggle the Yes state, the 
local X resource file, if it exists and its path is specified, controls the 
appearance and operation of X clients. If you toggle the No state, the 
default options control X clients.
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Edit X Resource
In the Options menu is a selection titled Edit X Resources. When selected, 
this option opens the Xresources file if it exists and its location is specified 
as described above. The file is opened using the Microsoft Notepad editor. 
If the file does not exist, it opens a new notepad file, so you can create a 
Xresources file.
49





Font Management

SmarTerm’s X Server provides access to the full set of X11R6 fonts, used 
by X programs, as well as the standard set of Microsoft Windows fonts, 
used by Microsoft Windows applications. You can get the best of both font 
libraries by configuring X Server to allow Microsoft Windows applications 
to access X fonts and to allow X programs to access Microsoft Windows 
fonts when font requests can’t be filled by X fonts.

This chapter describes X Server fonts and font management capabilities. 
Included is information on font sets, scaleable fonts, monospace fonts, and 
font server access. This chapter also includes a complete description of the 
Font Manager application, which allows users to convert custom fonts to 
the format required by Microsoft Windows.

X Server fonts
SmarTerm’s X Server includes the complete set of X11R6 fonts, converted 
to the FON format required by Microsoft Windows. 

X Server supports scaleable fonts and the X11R6 font server, which allows 
one or more hosts on a network to serve as a central storage area for all X 
fonts. 

Additional support is provided for users who wish to integrate their own 
fonts. These fonts must be in either the Bitmap Distribution Format 
(BDF) or the Portable Compiled Format (PCF). Through Font Manager, 
you can convert these fonts into the Microsoft Windows FON format. See 
“Launching the Font Manager” on page 54 for more information.
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Scaleable fonts
SmarTerm’s X Server supports scaleable fonts. If you request a scaleable 
font in a size that’s not available, the X Server scales the font from the 
closest matching font.

For a font to be scaleable, its name must conform to the standard X 
Logical Font Description (LFD) name convention. This format is fully 
defined in the MIT X Consortium Standard X Logical Font Description 
Conventions.

In addition, the folder containing the scaleable font must contain an LFD 
with the digit zero (0) in the PIXEL-SIZE, POINT-SIZE, and AVERAGE-
WIDTH fields, as illustrated in the following example:

-Adobe-Courier-Bold-R-Normal-0-0-75-75-M-0-ISO8859-1

where the zeros in the name string are used as place holders for the above-
mentioned fields.

Monospace fonts
The xterm program requires the use of monospace fonts. These fonts are 
composed of fixed-width characters that each occupy the same amount of 
horizontal screen space, much like the output of a typewriter. Monospace 
font families include Courier, Lucida, Typewriter, and Term. These font 
families and other general-purpose fonts are specified by their horizontal 
and vertical size (for example, 8x12).

The other supplied fonts contain proportionally spaced characters. These 
proportional fonts are used by X programs that are designed to vary the 
horizontal spacing between characters. X programs such as xterm that 
aren’t designed to use proportional fonts might produce displays that are 
difficult to read.

Font server access
SmarTerm’s X Server supports font access through the X11R6 font server. 
Font server access allows one or more hosts on the network to serve as 
central storage areas for all X Window System fonts. This eliminates the 
need for each PC to store the large set of fonts locally. It also provides 
access to a greater variety of fonts, since the font server supports 
transparent conversion of Speedo, PCF, BDF, and Type 1 fonts to 
X-compatible format.
52

 



Font server access
To access fonts through the font server, you must add information to the 
font path. Select the Options>Configuration>Fonts tab on the Control 
Panel, then select Font Path to display the current setting.       

In the text entry field, enter a string similar to the following:

tcp/hostname:port_id/catalog

where tcp indicates that the font server will be accessed over the 
network, hostname is the internet name of the font server machine, 
port_id is the default port number, and catalog is the full path to the 
directory containing the fonts you want to use. Separate multiple paths 
with commas.

For example,

tcp/taylor:7000/usr/R5fonts/75dpi,tcp/art:7000/usr/
R5fonts/100dpi

will allow access to the /usr/R5fonts/75dpi and /usr/R5fonts/100dpi 
directories through host port number 7000 on the “taylor” machine. 
Alternatively,

tcp/taylor2:7000

will allow access to all the font directories that are catalogued with the 
font server running on the “taylor2” machine.
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Font Manager
New fonts are often distributed with application programs. To use them, 
you usually need to convert them into the format used by Microsoft 
Windows. Font Manager allows this conversion.

Font Manager enables you to convert Bitmap Distribution Format (BDF) 
and Portable Compiled Format (PCF) font files into the FON format used 
by Microsoft Windows. BDF format files are text format fonts released for 
the X Window System. PCF format files are already-compiled fonts that 
can handle any server-specific byte order. 

Both of these formats must be converted (recompiled) to FON format files 
for use by Microsoft Windows. Font Manager allows you to perform this 
conversion automatically by selecting BDF or PCF font files and 
converting them with the press of a button. Font Manager also provides 
tools that allow you to select, delete, and preview fonts easily. You can also 
manually edit the files that control the naming, association, and selection 
of fonts, if you wish.

Launching the Font Manager
You can launch the Font Manager in one of two ways:     

• Select Start>Programs>SmarTerm folder>Utilities>X Font Manager.

or

• Select Utilities>X Font Manager from the Control Panel.

Four windows are in the Fonts Manager:

• The upper-left window contains the directory path of the .DBF/.PCF 
fonts to be converted.

• The lower-left window contains the list of .DBF/.PCF font files.

• The upper-right window contains the directory path of the converted 
.FON fonts. (In the dialog above, the .FON files display after you select 
the Fonts>75dip folder off the SmarTerm program folder.)

• The lower-right window contains the list of .FON font files.

Font files
Font file names include a root, consisting of a concatenation of meaningful 
abbreviations, plus an extension indicating the file format. In the 
following examples:
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timb12.bdf
timb12.pcf

“tim” stands for Times Roman, “b” designates bold, and “12” indicates the 
point size. The extensions indicate the file formats Bitmap Distribution 
Format and Portable Compiled Format.

While this naming convention is typically used, the actual file name can 
be anything and need not relate to any font specifications.

Navigation
As noted, Font Manager opens with the contents of the installation 
directory  displayed in both left and right panes. The current directory 
name is displayed above each pane. Select the network drive you want to 
open by picking it from the drop down list. Open the specific font source 
directory by clicking on the folder as you would when using File Manager.

Commands
The following commands are available as option buttons in the Font 
Manager dialog:

Convert
Converts BDF or PCF format font files appearing in the lower left pane to 
FON format files that can be used by the X Server. Navigate through the 
left pane to locate BDF or PCF font files, then select the files you wish to 
convert by clicking on each. In the upper right pane, open the directory in 
which the converted files should be placed. Click the Convert button to 
begin conversion.

The newly converted FON format files will be listed in the lower right 
pane. The Convert function automatically updates the FONTS.DIR file of 
the directory affected.

Select All/Deselect All
Allows you to select or deselect all files in the lower left and right panes.

Delete
This button becomes active whenever a FON format file is selected. You 
may delete one or several FON files at a time. Choosing Delete displays 
a message allowing you to confirm or cancel your operation. The Delete 
function automatically updates the FONTS.DIR file of the directory 
affected.

The following three commands are available under the Action:
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Build FONTS.DIR
If you have manually added fonts from an outside source, you must use 
this command to update the FONTS.DIR file. If you have used Font 
Manager to convert fonts to FON format, you do not need to use this 
command, since Font Manager updates the FONTS.DIR file automatically.

Edit Fonts Database
This command allows you to select a FON font and add or delete aliases 
for the font. A dialog box appears showing the FON files and the aliases 
for each. If you select a FON file, you can

• Show Font, which displays the characters in the font or 

• Add Alias, which allows you to assign an alias to the font.

If you select an alias, you can

• Edit Alias, which allows you to change the alias name or

• Delete Alias, which removes the alias for the FON file.

Show Font
This command allows you to preview any FON font converted by the Font 
Manager. Select a desired FON font from the right pane and click on the 
Show Font menu item. The Show Font window will open, displaying all of 
the font glyphs (characters) for the selected font set in the correct size and 
style.

If the font glyphs are too large to be displayed within the window, scroll 
bars will be activated to allow you to view the entire font set.

The Show Font window includes the font’s X Logical Font Description 
(XLFD), located immediately below the title bar. The XLFD is the legally 
registered font name as listed in the FONTS.DIR file. Note that you can 
preview only one font at a time. Only fonts converted with Font Manager 
can be previewed using Show Font.

Help
Complete online help for all Font Manager operations is available by 
clicking on the Help button.
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Font aliases
The font alias dialog allows you to specify aliases for fonts used by 
X programs. For example, suppose you are running an X program that 
uses a font named “times” by default for startup. To open the program 
with a font called “timb24.fon” instead, alias the “timb24.fon” font with 
the name “times.”

Select the font directory you wish to access using the upper right pane of 
the Font Editor main dialog. Enter the font alias dialog through the Edit 
Fonts Database menu command. You can show a font and add, edit, or 
delete an alias with this dialog.

Microsoft Windows fonts
All fonts used with SmarTerm’s X Server can be installed in Microsoft 
Windows, making them available to all Microsoft Windows applications. 
Adding or removing Microsoft Windows fonts is accomplished through the 
Microsoft Windows Fonts utility.
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To open the utility, click the Start>Settings>Control Panel icon, then click 
on the Fonts icon. This opens the Microsoft Fonts dialog (see the following 
figure), from which you can add and remove fonts. For further details on 
this utility, refer to the Microsoft Windows documentation.     

Automatic font substitution
SmarTerm’s X Server’s unique Automatic Font Substitution feature 
allows the X server to match an X program font request with the most 
similar Microsoft Windows font available, if the requested font isn’t found. 
This ensures that all font requests are satisfied.

Enable this feature by selecting the Options>Configuration>Fonts tab, 
and then by setting the Match to Closest Windows Fonts to On.
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X Protocol Trace is a diagnostic utility designed to monitor connection 
activity between  SmarTerm’s X Server and one or more X programs. It 
captures the X protocol communication data in binary format, then 
translates the data to an ASCII text file that can be examined for 
debugging purposes. Such detailed X protocol information is often useful 
for diagnosing and correcting problems with X programs.

The X Protocol Trace Control Panel allows users to start and stop a trace, 
specify which X programs to examine, set filtering parameters for 
translating captured data, and designate file names for the data collected.

This chapter describes the X Protocol Trace Control Panel in detail and 
explains how to activate a trace.

How X Protocol Trace works
The following diagram shows how X Protocol Trace interfaces with X 
programs and the SmarTerm X Server to capture and translate data:

Binary Data to File

ASCII Data for Analysis

X ProgramsTRACEX Server
59



X Protocol Trace
The X Protocol Trace process can be considered as two steps. First, set up 
and turn on the trace to monitor the connection and capture binary data to 
a file. Second, translate the data into readable ASCII format, using 
message filter options of your choice. Once the first step has been 
performed, the second step can be repeated to manipulate the data as 
many times as you wish.

Setting up a trace
Launch X Protocol Trace by:   

• Selecting Utilities>X Protocol Trace from the Control Panel.

or

• Selecting Start>Programs>SmarTerm folder>Utilities>
X Protocol Trace.

The X Protocol Trace Control Panel appears:  

Through this control panel, you can:

• Turn traces on or off.

• Trace all X programs or only the next program started.

• Choose or create a protocol filter.

• Choose the name of the raw collected data file.
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• Choose the name of the translated output file.

• Translate the raw protocol data into a readable format.

• View the translated output.

These operations are described in detail in this chapter.

Protocol Collection
The buttons at the top of the Protocol Collection section of the control 
panel allow you to turn data capture on or off. Before activating a data 
capture, you need to set up all trace parameters, as described in this 
section.

The X Programs to Monitor options can be found in the middle of the 
Protocol Collection section. Here you can choose All to capture protocol 
information on all X programs started after the trace is begun, or choose 
Next to monitor only the first X program started after activating the trace. 

At the bottom of the Protocol Collection section is the Full Protocol Data 
option. Disable this option to capture basic X protocol messages only, or 
enable the option to collect more detailed information associated with 
some X protocols, in addition to basic protocol messages.

Collected Data File Name
This section displays the full name and path of the file in which the raw 
binary data collected during the trace is stored. The default file name is 
TRACE.TRC, located in the SmarTerm program folder. 

To change this name:

1. Click Browse to bring up the standard Windows Open dialog.

2. Type a new file name. (The file extension .TRC is added automatically; 
don’t enter a different extension.)

3. (Optional) To specify a location other than the X Server folder for this file, 
use the browser to navigate to the new folder, or type in a full path in front 
of the file name.

Protocol Filter
This section allows you to specify the protocol functions you wish to view 
and the format level of the translated data capture for each of the four 
categories of X protocol messages.
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All previously defined filters appear in the list box in this section. This 
includes the default filter (“all”), which specifies full data capture of all 
messages in all four protocol categories.

1. Do one of the following:

• Select a filter by clicking its name within the list box.

or

• Specify a different set of filter parameters by clicking New. This causes 
the following dialog to appear:      

2. Type a filter name of up to eight alphanumeric characters and click OK to 
accept the name. This causes the Protocol Filter dialog to appear:       

3. Use this dialog to specify the X protocol functions to be monitored when 
this filter is selected.
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For each of the four message categories (Requests, Events, Replies, and 
Errors), you can select specific functions to view. For example, when you 
select the Requests category, the function list box fills with all appropriate 
X requests. Scroll through the list and click on each function you wish to 
view, or choose Exclude All or Include All. To exclude a function that’s 
already highlighted, click on it. In the preceding example, all functions are 
selected.

4. Once you have chosen the functions you would like to view within a 
message category, you can then set the format level of the data collection. 
If you want, you can set a different format level for each message category. 
Five format levels are available:

• Off—No data translation is performed on the message category.

• Names—Only the names of the selected functions are translated within 
the message category.

• Main—In addition to names, the most important protocol message 
fields are also translated for selected functions within the message 
category.

• Full—All protocol message fields are translated for selected functions 
within the message category.

• Hex Dump—All protocol message fields, plus associated hexadecimal 
values, are translated for selected functions within the message 
category.

5. Proceed through the four message categories, selecting the functions to 
view and the format level for each. When finished, click OK to save your 
selections for current use or for retrieval at a later time.

➤ To modify a previously defined protocol filter (other than “all,” which is 
fixed and cannot be modified), double-click on the filter name in the 
protocol filter list box. The filter dialog (see the previous figure) appears, 
from which you can change the functions to be monitored or the format 
level of any protocol message category.

Translated Output File Name
This section displays the full name and path of the file in which the 
readable translation of the trace data is stored. The default file name is 
TRACE.TXT, located in the SmarTerm X Server program folder.

To change this name:

1. Click Browse to bring up the standard Windows Open dialog.
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2. Type a new file name. The file extension .TXT is added automatically; 
don’t enter a different extension.

➤ If the resulting path in the Translated Output File Name field contains 
any spaces, you get an error message when you click View. To avoid this 
problem, type the MS-DOS equivalent of the path and file name, for 
example: C:\PROGRA~1\PERSOFT\STENTER\TRACE.TXT.

Initiating a trace
Once you have specified the captured data file name and determined 
whether to monitor all X programs or only the next program started, you 
can begin the trace data collection process by clicking On.

• If the X Server isn’t running when you click On, you’re asked if you want 
to start it. Click Yes to launch the server or No to cancel the trace 
activation.

• If an X program is running when you click On, the trace monitors that 
program immediately.

• If no X program is active, the trace begins as soon as a new X program 
is started.

After activating a trace, the X Protocol Trace Control Panel might block a 
program window that you wish to access. If it does, press Alt-Tab or use 
your mouse to return to the program window.

➤ If you have selected All under X Programs to Monitor, remember that the 
trace continues until you turn it off. If you have selected Next, the trace 
continues either until you turn it off or terminate the program. Allowing 
Trace to run for a long time might result in very large data capture files.

Translating and viewing output
After performing a trace data capture, selecting protocol filters, and 
defining a translated output file name, you’re ready to translate and view 
the trace data.

• Click Translate to automatically take the binary data file resulting from 
the trace and apply the protocol filters to produce a readable ASCII file 
for analysis. The Translation status box appears briefly.

• Click View to read the data file. You can then make any changes you 
want to the file. 
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Smarterm’s X Server supplies a plug-in X server for use with Internet 
Explorer and Netscape Navigator. The Web Enabled X plug-in is installed 
in your web browser’s plug-in directory during installation. The X server 
plug-in allows you to launch and display X clients from within the 
contents of a Web page. Users can immediately access UNIX applications 
from within their favorite Web browser.

Web browser X clients
Your system administrator has the capability to configure X clients so 
they can run within your Web browser. Currently the X server supports 
X clients in Netscape Navigator and Microsoft Internet Explorer.

You can use this capability to directly access UNIX® based X clients on 
network hosts without starting a complete X server. Start one of the 
supported Web browsers and enter the location of the HTML file your 
system administrator has created. You may also save this location as one 
of your bookmarks.

Configuring X clients
The system administrator must be proficient in setting up the 
environment for a user to initiate a X client with the Web browser. 
Typically this environment is established through a set of files that specify 
services required to run the client. These files may include HTML, RX, 
and batch files.
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File test.html:
---------------

<!--$XConsortium: xclock.html /main/2 1996/10/08 15:07:30 kaleb $-->
<html>
<EMBED version=1.0 type=application/x-rx src="test.rx" width=400 height=250>
<head>
<title>X Applications on the Web - xclock demo page. </title>
</head>

 

<body>
<a name="begin">
<h1> X Applications on the Web - xclock <br> Demo page. </h1>
</body>
</html>

File: test.rx
-------------

<PARAM Name=VERSION Value=1.0>
<PARAM Name=REQUIRED-SERVICES Value=UI>
<PARAM Name=UI Value=X>
<PARAM Name=ACTION Value=http://puffin/cgi-bin/test.bat>
<PARAM Name=WIDTH Value=200>
<PARAM Name=HEIGHT Value=200>
<PARAM Name=EMBEDDED Value=YES>
<PARAM Name=X-UI-INPUT-METHOD VALUE=YES;foo>
<PARAM Name=X-UI-LBX Value=YES>
<PARAM Name=X-AUTH VALUE=MIT-MAGIC-COOKIE-1>

File: test.bat
--------------

xclock -display puffin:1 -bg green -fg blue

For additional details for executing remote X clients from a web browser, 
refer to the X Consortium page: http://www.camb.opengroup.org/tech/
desktop/x/
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Performance Application

The performance tuning application allows you to optimize the graphics 
performance of the X server. Microsoft Windows provides high speed 
operations for several common graphic elements such as circles and 
dashed lines. These specific operations are often faster than the 
equivalent X window system operations. This application automatically 
determines whether the Microsoft or X windows drawing method is faster 
for a series of graphics operations.

Your system’s combination of hardware and software determines which 
drawing method is fastest for your computing environment. This 
application should be run after first installing Smarterm’s X Server or any 
time you change graphics cards, install new graphics drivers, or change 
your system's display resolution. You can start the X Server Performance 
Tuning application from the Options menu of the X Server Control Panel 
or from the SmarTerm X Server program group.

Automatic Operation
Start the X Server Performance Tuning application from the X Server 
Control Panel. If no X server is running or if all running X servers use 
XDM, the Performance Tuning application notifies you and offers to start 
a server. The Performance Tuning dialog box then appears.
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Select Accelerated Drawing Mode to save the fastest drawing method for 
each of the tests. Click Run All Tests box. A graphic representation of the 
individual test appears next to the application dialog. When it finishes, a 
bar graph displays indicating whether the Microsoft or X windows 
drawing method is faster. When all tests are completed, click Accept box. 

Click Save to save the new configuration, close the Performance 
application, and close the X server. The new settings take effect as soon as 
you click Save.

Manual Selection
The Performance Tuning application allows you to override the automatic 
drawing method selection process. Start the Performance Tuning 
application from the X Server Control Panel.

Select the specific graphic test you wish to run from the list box. When you 
click Run Test, a graphic representation of the test appears next to the 
application dialog. Upon completion of the test, a bar graph indicates 
whether the Microsoft or X windows drawing method is faster. Click 
Accept to include the faster method in your X server configuration. 
Selecting Cancel will reset your configuration to the previous setting. 
Repeat this process with the remainder of the tests.

If you know which drawing method you want for each graphic operation, 
simply select the graphic operation and then select the drawing method. 
This will bypass running the test.

Click on Save to save the new configuration, close the Performance 
application, and close the X server. The new settings take effect as soon as 
you restart the X server.

You are not reminded to save performance changes when you close the 
X server. You must explicitly save the changes for them to be effective.
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Keymap Editor

SmarTerm X provides an easy-to-use graphical keymap editor to allow you 
to customize any keyboard for use with the SmarTerm X Server.

Using this tool, you can define (or “map”) the X key code sent to X 
programs whenever you press any key. The file that stores the mappings 
of keys to these X key codes (or “keysyms”) is called a keymap. Each 
physical key can have four keysyms:

• One keysym when the key is pressed with no modifier, 

• One keysym when the shift key is pressed when the key is pressed,

• One keysym when the mode key is pressed when the key is pressed,

• One keysym when the mode and shift keys are pressed when the key is 
pressed.

SmarTerm X includes several predefined keymaps. Using the keymap 
editor, you can open an existing keymap and modify any or all of the key 
mappings it contains. When this keymap is selected through the 
SmarTerm X Control Panel’s Keyboard Preferences dialog box, your 
keyboard will be mapped as you have specified.

This chapter includes detailed information on the keymap editor tool.

Accessing the Keymap Editor
The keymap editor may be started by clicking on either the keyboard icon 
from the SmarTerm X program group, by selecting the same icon from the 
SmarTerm X Control Panel’s tool bar, or by selecting the Keyboard 
command from the SmarTerm X Control Panel’s Options menu. Based on 
the key layout of a IBM PC 101 keyboard, when the keymap editor is 
started, it presents the following graphical keyboard-like interface.
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➤ The keymap editor is not available from the Options menu if you have 
installed SmarTerm X from a file server.

The keymap editor automatically detects and loads the correct keyboard 
style file from the MS-Windows setup information. The symbols displayed 
on the keycaps will be appropriate for your localization. This means if 
Microsoft Windows is configured for French, French keycaps are 
displayed.

If you attempt to load a keymap that has a different number of keys from 
the keyboard defined in Windows, an error message will display indicating 
that the application cannot read the format of the file.

You can edit only keymaps with the same number of keys as the keyboard 
defined for Windows. The keymap editor loads a keymap equivalent to 
that of the keyboard defined for Windows.

➤ Saving the keymap will overwrite the keymap you initially tried to open 
unless you specify a different file name.

Keymap reference
Complete information concerning keymaps, keysyms, and keycodes can be 
found in Volume Two of the Xlib Reference Manual by O’Reilly & 
Associates.

Key color conventions
The keymap editor color-codes certain keys depending on their status:

Blue Indicates that the key is selected for redefinition

Yellow Indicates that a Shift, Alt, or Num_lock key is depressed

White Indicates that the right-click pull down menu is active for this 
key.

If the text on a keycap is colored black, that key is not mapped to any 
symbol. If the text is blue, that key is mapped.

Modifying a keymap
To modify the mapping of any key in the current keymap, simply select the 
key symbol from the keysym list in the right pane, then drag and drop it 
on the target key. Alternatively, you can highlight the key then double 
click on the key symbol to map the key.
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Modifying a keymap
The View menu contains the tools for modifying a keymap. You can toggle 
on and off both the Keysyms List and the Status Bar selections. Initially, 
both are on.

The ModeSwitch menu specifies which modes are enabled for the 
keyboard mapping.

The Mapping State menu specifies whether dragged keysyms are mapped 
to the Regular value of a key, its Mode value, or its value when the Mode 
and Shift keys are also pressed. To assign a keysym to a Shifted key, click 
first on a shift key, and then drag the keysym to the key. The shift key 
displays in yellow during this process.

Keysyms list
This option controls the presentation of the keysym groups and their 
associated symbols. When toggled on, these items are displayed in the far 
right pane of the keymap editor. The following keysym groups are 
available:

Double-click on the group name to display the available keysyms within 
that group.

The most commonly used keysyms can be found in the “Keyboard” group.

Status bar
This option controls whether or not the status bar at the bottom of the 
keymap editor is displayed. For keys under the cursor, the status bar will 
display the PC key name, currently mapped keysym and the 
corresponding hexadecimal value, if any. Appropriate action prompts will 
also be displayed here.

APL Arabic Cyrillic DEC

Greek Hebrew HP IBM 3270
ISO 9995 Katagana Keyboard Korean

Latin-1 Latin-2 Latin-3 Latin-4
ModeSwitch OSF Publishing Special

Sun Technical Thai
71



Keymap Editor
Saving and using keymaps
Once you have modified an existing standard keymap, use the Save As 
selection under the File menu to preserve your changes. You may save 
multiple keymap files with the .XKB extension such as KEYMAP1.XKB, 
KEYMAP2.XKB. The last saved keymap file mapping is written to a file 
named XOFTWARE.KMP and is used by the X server as the current 
keymap. This keymap will be assumed for any new client programs you 
define.

Modifiers
Modifiers are keys that change the effect (or state) of other keys. For 
example, the Shift keys are normally defined as shift modifiers. When one 
of these keys is depressed, a letter key will change from lower case to 
upper case.

The standard categories for modifier are Shift, Lock, Control, and Alt 
(Mod1 is equivalent to Alt). Typically, the left and right Shift keys, the 
Caps Lock key, the left and right Ctrl keys, and the left and right Alt keys 
are used as standard modifiers. You can, however, define any non-modifier 
key as one or more of these modifiers.

Right click on the key you wish to define as a modifier; then select the 
modifier type for that key. Besides Shift, Lock, and Control, you can define 
the key to be a Mod1, Mod2, Mod3, Mod4, or Mod5 modifier. A key can be 
only one type of modifier key. However, multiple keys can be the same 
modifier. For example, the default keyboard has two Shift modifier keys.

➤ A mode modifier is effective only when the applicable ModeSwitch is 
enabled from the ModeSwitch menu. A check mark denotes that a mode is 
enabled.
72

 



Additional keymapping
Additional keymapping
A right mouse click on an ordinary key (e.g., non-modifier key) of the 
graphical keyboard interface presents the following menu items. A 
different menu, described later, is presented for the modifier keys.

Macro can be used to assign multiple keystrokes to a single key. This is 
useful for certain applications and terminal emulation functions. For 
example, you can assign the following sequence to a specific key to exit the 
“vi” editor in UNIX: Esc, :, q, !, Enter. To use this feature:

Begin by right clicking on the key which should receive the macro 
definition. A menu of special keys will be presented. To define the symbols 
the target key will now send, type them in the Macro box, or, alternately 
scroll down and double-click on a special key, such as backspace, delete, or 
enter, to add it to the macro definition. Any number of special keys may be 
selected. Select OK when done, or cancel to discard the changes.

For convenience, once again your macros changes are displayed in the 
status line.

User Defined Keysym is used to map any key to any hexadecimal value.

To do this, first select a key you wish to assign a hexadecimal value. Right-
click and select User Defined Keysym. Enter a hexadecimal value (e.g., 
0x3535) and then select OK (or Cancel if you wish to exit without 
changing).

Enter up to 4 bytes. The new value will be reflected in the status line.
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Shift Modifier defines the selected key as a Shift modifier.

Lock Modifier defines the selected key as a Lock modifier.

Ctrl Modifier defines the selected key as a Ctrl key modifier.

Mod1 Modifier defines the selected key as a Mod1 modifier.

Mod2 Modifier defines the selected key as a Mod2 modifier.

Mod3 Modifier defines the selected key as a Mod3 modifier.

Mod4 Modifier defines the selected key as a Mod4 modifier.

Mod5 Modifier defines the selected key as a Mod5 modifier.

Reserve for MS-Windows is used to reserve a key press for exclusive 
use by Microsoft Windows. When this is done, the key press will be 
invisible to X11 clients. Right-click on the desired key, then left click on 
the menu item. The status bar will reflect the change.

This is most commonly done for the F10 and Alt keys, as these keys are 
often used by both MS-Windows and X11 programs.

Map to Compose allows you to define a sequence of up to three keys to 
define a special key. The first key you select is the key that will invoke the 
composed key. The modifier key applies a modification to the first selected 
key. If you wanted Alt on the right side of the keyboard modified with a 
shift, the first key would be Alt, the modifier key would be Shift, and the 
last key would be unique to finalize the sequence for the special keys.

Revert to Default discards any changes made to the highlighted keysym 
and resets the keysym to system defaults. 

Unmap discards the current key mapping. Unmapped keys will send 
nothing and the status line will display “No Symbol” as their value.

➤ Each key can be only one type of modifier.

If you right-click on the NumLock key, the shortcut menu presents only 
two commands.

Revert to Default reassigns the default keysyms to the NumLock key.

Reserve for MS Windows prevents any keysyms from being assigned to 
the NumLock key. Windows controls the use of the NumLock key.
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Map to compose
A right-mouse click on Alt or Ctrl activates the Map to Compose feature of 
the Keymap Editor. This feature is slightly different than the Map to 
Compose associated with regular keys. This software allows you to specify 
a sequence composed of one or more modifiers and a regular key that 
when entered through an X client will insert a character not found on the 
keyboard. For example, using an English keyboard, you can define a 
sequence that will insert a foreign diacritical mark. Whether the Shift key 
is ON or OFF is optional.

Right-click on the Shift key to highlight it if you want that to be part of the 
compose sequence. This key functions slightly differently than the other 
modifier keys, so it must be selected first; also it cannot be the only key 
selected. Now right-click on one or more modifier keys, Ctrl and/or Alt, to 
add to the sequence. Left-click on the Map to Compose menu bar. The 
status line will verify the key selection and will indicate that the compose 
sequence is currently mapped to none. Highlight a regular key with a left 
mouse click. Drag and drop the desired keysym from an open keymap to 
the highlighted regular key. This completes the mapping.
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X Log File

SmarTerm X Server automatically creates a new log file at the start of 
every session. This log file is updated throughout the session to record any 
error messages or warnings that might occur. This file can thus be opened 
to gain diagnostic information concerning any X program that might fail 
to run properly.

The log file name is LOGFILn.TXT where n is the number of the display 
used by the X server. The first log file is named LOGFIL0.TXT; the next is 
LOGFIL1.TXT; and so on.

The Log File Browser provides an easy means of viewing the log file. You 
can also use this tool to print the file or to copy text to the Clipboard for 
transfer to another application. This chapter describes the log file and the 
Log File Browser.

Launching the Log File Browser
The Log File Browser icon can be found in the SmarTerm X Server 
program group. Click this icon to start the Log File Browser
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X Log File
A dialog will appear where you must select the specific log file to view. 
Once you select a log file, the following screen appears, displaying the 
current contents of the selected log file:

• To print the log file, select Print from the File menu, or click the  
icon in the toolbar.

• To copy any portion of the text, highlight it with the mouse and 
select Copy from the Edit menu, or click the icon in the toolbar. The 
text will be copied to the Microsoft Windows Clipboard. You can 
then copy it to any Windows or X program.

To search for text within the file, select Find>Edit or by press Alt-F3.

Note that you cannot edit the actual text of the log file, because it is 
read-only.
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Color

Color handling in the X Window System is complex because of the need for 
portability to many different types of displays. Microsoft Windows further 
complicates color handling by controlling which application has primary 
access to the system palette (the colors actually available on the system, 
shared by all Microsoft Windows applications) while maintaining a high 
level of color quality for the remaining applications.

This chapter begins by describing how color is handled in the X Window 
System. It then describes how color is handled by both Microsoft Windows 
and SmarTerm’s X Server.

X Window System color support
The X Window System supports color through the use of colormaps and a 
Color Name Database.

Colormaps
Colors that you see on your monitor are defined by a combination of the 
intensity of red, green, and blue. This is called the RGB color model, the 
most commonly used model for color displays. RGB color definitions are 
stored in the elements (called colorcells) of lookup tables. These tables, 
known as colormaps, are stored in the server.

When X programs attempt to use color, they don’t specify a pixel value and 
a color to be put in the specified cell in order to draw a given color. Instead, 
they request access to a colorcell in a colormap. The server responds by 
returning a pixel value to the X program.
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The range of colors available on the screen is a function of the number of 
bit planes (called screen depth, which determines the number of 
simultaneously displayable colors) and the width of the hardware color 
registers. If eight bits are available for each primary, for example, then the 

range of colors is 256
3
, or about 16.8 million.

Virtual colormaps are supported by X windows so that more than one 
colormap can be maintained, even though only one can be in use at a time. 
Virtual colormaps are swapped in and out of the hardware colormap by 
the window manager.

Color Name Database
The Color Name Database is the mechanism by which the X Window 
System simplifies color specification and promotes color sharing. The 
Color Name Database translates string color names into RGB values. 
Because two X programs can share colorcells only if both programs 
allocate colorcells with the same RGB value, the Color Name Database, by 
providing a commonly available RGB definition, conserves the number of 
colorcells required.

Another problem resolved by the Color Name Database is the difference in 
actual colors displayed by various monitors. Changing the RGB values in 
the database allows you to adjust the RGB values corresponding to each 
color name to make sure that the appropriate color appears on the screen.

Screen visuals
A screen visual describes the characteristics of a virtual colormap created 
for use on a particular screen. Each screen visual contains information on 
one way to use the capabilities of the display hardware; there might 
actually be several applicable screen visuals.

The six screen visual classes differentiate between color and monochrome, 
between whether the colormap is read/write or read-only, and between 
whether a pixel value provides a single index to the colormap or is 
decomposed into separate indices for red, green, and blue values. 
Following is a comparison of the screen visual types:

Colormap Type Read/Write Read-Only

Monochrome/Gray GrayScale StaticGray
Single Index for RGB PseudoColor StaticColor

Decomposed Index for RGB DirectColor TrueColor
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Microsoft Windows color support
Screens that support DirectColor can theoretically support any of the six 
screen visual classes. Screens that support TrueColor can also support 
PseudoColor, GrayScale, StaticColor, or StaticGray. Screens that support 
PseudoColor can also support GrayScale, StaticColor, or StaticGray. 
Finally, screens that support GrayScale can also support StaticGray.

The capabilities of a display hardware station can theoretically support a 
visual class. In practice, however, the server implementation determines 
whether or not the visual class is supported.

Microsoft Windows color support
Microsoft Windows color support is provided by means of color palettes.

Color palettes
Microsoft Windows color palettes provide the interface between Microsoft 
Windows applications and a color display device. Color palettes access the 
color capability of a display device by managing the device’s physical (or 
system) palette, if one is available. Typically, devices that can display at 
least 256 colors use a physical palette.

Applications are created with one or more logical palettes. Each entry in 
the palette contains a specific color. The application, when rendered on the 
display, specifies an index into one of its logical palettes to indicate the 
desired color rather than a specific color value.

Microsoft Windows acts as the mediator between applications—each of 
which may have several logical palettes—when the number of colors 
requested for simultaneous display exceeds the capability of the display 
device. Microsoft Windows first attempts to exactly match entries in the 
logical palette to current entries in the system palette. If an exact match 
isn’t found, and an unused entry exists in the system palette, Microsoft 
Windows sets the entry in the logical palette to current entries in the 
system palette. When all entries in the system palette have been used, 
Microsoft Windows tries to take unmatched logical entries and match 
them as closely as possible to entries already in the system palette.

Default palette
Microsoft Windows sets aside 20 static entries in the system palette 
(called the default palette) to aid in logical palette color matching. To 
ensure that the active window has the best color display, Microsoft 
Windows satisfies the color requests of the foreground window first.
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Color support
This section describes the color support provided by SmarTerm’s X Server.

Display devices
SmarTerm X Server works with any Microsoft Windows-compatible 
display device. The X Server supplies screen visual support for display 
hardware with screen depths of 1, 4, 8, 16, or 24 raster memory planes 
(bits per pixel).

Screen visual
As described earlier, a screen visual describes the characteristics of a 
virtual colormap that has been or can be created for use on a particular 
screen. For displays that support Microsoft Windows color palettes, the 
SmarTerm X Server makes five screen visual choices available: True 
Color, PseudoColor, GrayScale, StaticColor, and StaticGray.

PseudoColor and GrayScale visuals have changeable colormaps, while 
StaticColor and StaticGray have immutable colormaps. With immutable 
colormaps, all colorcells are read-only and all RGB values are preset.

The advantage of changeable colormaps is that X programs can select 
exactly the color you want (as long as your display hardware supports it) 
and your application can change the color at will. This is why PseudoColor 
is the best screen visual for 256-color displays.

You can change the screen visual through the Configuration dialog in the 
X Server Control Panel. Select Options>Configuration>Graphics tab, and 
select the Screen Visual option. 

The screen visuals displayed can vary depending on your display 
hardware; only the color models that your display hardware can support 
are presented. The full array of supported screen visuals is described 
below.

TrueColor
TrueColor is the most powerful of the screen visual classes. It is supported 
only on displays with 16- or 24-bit color capability. With this option 
selected, X applications can select 32,768 colors for 16-bit cards, or 16.8 
million colors for 24-bit cards.
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PseudoColor
This is the most versatile screen visual class and is supported on displays 
with changeable hardware colormaps (color displays that support 
Microsoft Windows palettes). With this option selected, X applications can 
define and select the maximum number of colors supported by the display 
(256 for a screen depth of 8 bits).

GrayScale
Like PseudoColor, GrayScale requires a display device with a changeable 
hardware colormap. With this option selected, X applications will attempt 
to map colors into shades of gray that provide adequate contrast. (The 
number of shades that can be displayed simultaneously depends on your 
display hardware.)

StaticColor
This screen visual is the default for displays with an immutable 
(unchangeable) hardware colormap, such as standard VGA monitors. With 
this option selected, X applications map each color request to the closest 
available color.

StaticGray
Like StaticColor, StaticGray is used for displays with an unchangeable 
hardware colormap, such as black-and-white monochrome monitors. 
These displays feature a single-plane screen with a two-element read-only 
colormap. With this option selected, X applications map each color request 
to either black or white.

Reserve system colors
Enable this option through the X Server Control Panel’s Configuration 
dialog (under Graphics) to allow the Color Map Reservation System 
(CMRS) to protect 18 of the 20 static colors of the default palette. This 
protects the ability of Microsoft Windows to match color requests. If this 
option isn’t selected, all but two colors in the Microsoft Windows system 
palette are available for X programs.

If the display hardware or selected visual doesn’t support Microsoft 
Windows palettes, this option is unavailable.
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Preallocate colors
Microsoft Windows restricts the use of a few colors at the beginning and 
end of the 256-color palette. These colors include black, white, and various 
colors used in icons and menus. Because Microsoft Windows applications 
cannot use these colors, the SmarTerm X Server will by default report to X 
programs that at most either 236 or 254 colors are available in the palette.

This is usually not a problem, because most X programs do not require the 
restricted colors. However, some X programs will refuse to run unless they 
have access to the full 256-color spectrum.

The Preallocate Colors option may be accessed through the Configuration 
dialog box in the X Server Control Panel. Select Configuration from the 
Options menu, click the Graphics tab, and click this option.

Choose Restrict to limit the preallocation of reserved system colors to the 
default colormap. Choose Always (default) unless you are running a 
program that requires write access to all colors in a non-default colormap, 
even though some of these colors cannot be displayed. In that case, the 
applications will run correctly.

Change white pixel
On changes the RGB value of white from 255 to 1. Toggle to On only if you 
are running an X client that requires white to be defined as 1.

Modify color cursor
Some cursors may not be visible on certain backgrounds. Choose "On" to 
make such cursors visible. Note that this will change all color cursors, so 
this should be enabled only in special cases. This option goes into effect 
after the next X client is launched.
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RGB Editor
The RGB Editor allows you to easily modify the definition of color names 
used by the X server. This information is stored in the RGB.TXT file. The 
RGB.TXT file contains many predetermined color names including 
definitions for SCO UNIX and Silicon Graphics specific color names. You 
can add new colors, modify existing colors, or delete colors from the color 
database. Colors are differentiated from one another by the value (or 
intensity) of red, green, and blue that they contain. The range of this value 
is from 0 to 255.

Add a color
To add a color, first select an existing color from the scrolling list. The 
name will be highlighted and the color will be displayed in the lower right 
pane of the dialog. Move the slider bars or click on the arrows controlling 
the red, green, and blue values to create the color you want. You can create 
the color visually or by specifying values for each component. Highlight 
the original color name in the box below the scrolling list and type the new 
color name. Click the add button to enter the new color in the current 
RGB.TXT file.
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Modify a color
Specific colors may appear different on different monitors. You can change 
a color’s appearance while retaining the original color name. To modify a 
color, select it from the scrolling list. The name will be highlighted and the 
color will be displayed in the lower right pane of the dialog. Move the 
slider bars or click on the arrows controlling the red, green, and blue 
values to modify the color as you want it to appear. Click the modify 
button when you are satisfied with the appearance or have the red, green, 
and blue values correct.

Delete a color
To delete a color, select it from the list box and click the delete button. It 
will be removed from the RGB.TXT file.

Search for a color
Highlight the color name in the box below the scrolling list and type the 
name or first few letters of the color you are searching for. Click on the 
magnifying glass icon to the right of the name to find the color if it exists 
in the RGB.TXT file.
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Troubleshooting

This chapter offers procedures to help you quickly resolve any problem 
you might encounter when using Smarterm’s X Server.

Troubleshooting information is provided for problems encountered while 
running the X Server or starting X programs. Problems encountered 
within X programs are also addressed.

Server troubleshooting
If the SmarTerm X Server can’t be started, a message box appears. 
Identify the error type or specific message below and follow the procedures 
to resolve the problem.

Network-related errors
Ping is a network utility that helps to isolate or eliminate a network 
connection as a source of error. This is a useful first step for resolving all 
network-related errors.

From Windows, open an DOS window and type PING HOSTNAME. If the ping 
is successful (a response similar to “hostname is alive” appears), your 
network connection is functioning correctly.

If the ping is unsuccessful, repeat the ping using an IP address instead of 
a name (for example, PING 124.120.24.8). If this succeeds, there is 
probably an invalid entry in the hosts file on your PC or on the host. 
Check these files carefully for typos or misspellings.

If the ping still fails, the network probably isn’t functioning properly. 
Check the network card, network drivers, and cables. Verify that others on 
your network are running and that the host is in operation.
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“Fatal error during initialization.”
“Not enough free memory to run X Server.”
When one of these warnings appears, an additional message is written to 
the log file. Start the X Log File Browser and look for one of the following:

“Cannot allocate black and white pixels in WScreeninit.”

The X Server is unable to allocate black and white colors from the 
installed video driver. This might occur if you’re using an unsupported 
video driver. Make sure your video card and driver support at least 16 
colors or GrayScale. Check the Windows Control Panel>Display, or consult 
your system administrator for assistance.

“Cannot allocate buffer for rgb.txt file: RGB.TXT.”
“Cannot open rgb.txt file: RGB.TXT.”
Make sure the RGB.TXT file is located in your SmarTerm program folder. 
Contact Technical Support for further assistance.

“Cannot create font temporary folder: ‘C:\PROGRAM\FILES\PERSOFT\
STENTER\c009c818’.”

The specified folder cannot be created, typically because the name is 
invalid or you don’t have write privileges for the folder. This occurs 
primarily in network installations.

Select Options>Configuration>Fonts tab from the X Server Control Panel, 
then select the Temporary Font Path option. Change the entry to a folder 
for which you have read/write permissions.

“Network connection error: Error binding TCP socket.”
“Network connection error: Error creating TCP socket.”
The server was unable to bind a process to the TCP/IP stack or create a 
TCP socket connection, typically because no TCP sockets were available. 
Check your network configuration to make sure that at least six TCP 
sockets are available. Also verify that your network is operational. Check 
for multiple instances of winsock.dlls.

“Failed to allocate memory for scratch GCs.”
“Failed to create root window.”
“Failed to create the default stipple.”

Contact Technical Support.

“Initializing atoms.”
“InitOutput could not initialize any screens.”
Contact Technical Support.
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“Network initialization failed. Verify that network driver is installed 
properly.”
Your network is improperly configured. Verify that the proper drivers are 
being loaded and that the TCP/IP transport is operational. Refer to your 
TCP/IP network documentation for information.

“Server restarted. Jumped through uninitialized pointer?”

Contact Technical Support.

“The color ‘red’ is wrong in the rgb.txt file. rgb=255,0,0.”
This indicates that a color was specified incorrectly in the RGB.TXT file. If 
you’re familiar with RGB colors, open the file and correct the entry. 
Otherwise, contact Technical Support.

“Unable to allocate memory for root window table.”
“Unable to allocate memory for the client array.”
“Unable to allocate memory for the server client.”
“Unable to allocate memory to init server resources.”

Not enough memory resources are available for the server. Try closing 
Windows applications or restarting Windows before starting the server 
again. If necessary, check your virtual memory usage by opening the 
Microsoft Windows Control Panel and clicking on the System icon, then 
the Performance tab. You might need to enable or increase your virtual 
memory (consult online help for assistance). If your memory resources are 
still not adequate, you might need to add RAM to your PC.

“Unable to create connection block info.”
“Unable to create root tile.”
Contact Technical Support.

“Unable to initialize pointer and keyboard.”

Your mouse or keyboard isn’t responding. Check all connections, then 
check the Windows Control Panel to verify that the correct keyboard is 
selected and the proper mouse and mouse driver is installed.

“Unable to open default font ‘fixed’.”
“Unable to open default cursor font ‘CURSOR.FON’.”
Either the alias to the specified font is missing or Windows is unable to 
open the font. This procedure might vary. Do the following:

Open the FONTS.ALI and FONTS.DIR files in the \FONTS\MISC folder 
of your SmarTerm program folder. Find the file to which the font in 
question is aliased and make sure the file exists. Also make sure the 
aliased file is monospaced, not proportional.
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Open the Microsoft Windows Control Panel and double-click the Fonts 
icon. Select View>Options, then select the True Type tab. Disable the 
option Show only TrueType fonts in the programs on my computer.

 “Unable to set default font path ‘C:\PROGRAMFILES\PERSOFT\
STENTER\FONTS\MISC’.”
Either the fonts in the specified folder have been deleted or moved, or your 
font path is incorrect.

If the fonts were moved, move them back to their proper location. If they 
were deleted, run setup again to reinstall them.

If the fonts are in their proper location, select Options>Configuration>
Fonts tab from the X Server Control Panel, and select the Font Path 
option. Make sure the entry includes no misspellings and that each full 
font path is separated by a comma.

“Application Error: X caused a General Protection Fault. . . .”
General Protection Faults (GPFs) are Microsoft Windows errors that are 
usually caused by memory conflicts within Windows. Make a note of the 
information listed on the error dialog and see your system administrator 
for assistance.

 “Cannot open udp_socket.”
This error is usually encountered after an abnormally terminated login 
session. Often it can be cleared by closing all applications down, exiting 
Windows, and doing a hard reset (shutting down the PC rather than 
simply rebooting). This resets the registers in the network card.

If you repeatedly get this error, check your network software configuration 
and see how many UDP sockets are available; usually only two are 
required. Occasionally this error reflects a problem on the host side, so be 
sure to alert your system administrator of the situation.

“Network connection error. Network is improperly configured.”
Either the X Server is unable to locate the correct TCP/IP library interface 
driver (WINSOCK.DLL), or the network isn’t configured properly.

Make sure the correct WINSOCK.DLL is being loaded. To do so, copy the 
WINSOCK.DLL from your network software to the Windows folder. (The 
X Server searches for this file first in the Windows folder, then in the 
SmarTerm folder, and finally in the DOS search path. Since the X Server 
loads the first WINSOCK.DLL it encounters, it’s imperative that if more 
than one WINSOCK.DLL exists on your system, the X Server locates the 
one associated with the TCP/IP stack you’re running.)
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Winsock Error Messages
“Operation would block.”

If you’re using rexec to connect to the host, try telnet instead. The host 
might be responding too quickly for the rexec to make the connection.

“Operation already in progress.”
The Windows Socket Interface (Winsock) is already loaded or in use. This 
typically occurs when more than one application tries to load the Winsock 
DLL or different versions of it. Restarting your computer might resolve 
the problem. Otherwise, check for memory conflicts that might be 
confusing the network software. (See your system administrator for 
assistance.)

“Protocol not supported.”

The requested protocol isn’t supported by your network or host system. 
Try using a different login method, and verify proper connection to the 
host.

“Socket type not supported.”
The requested socket type isn’t supported or not reachable. Check your 
network configuration file and make sure there is an entry for the type of 
socket being requested (typically UDP or TCP). Verify that the parameters 
for these sockets are valid. Also check the network card and memory 
configurations.

“Protocol family not supported.”

The option or operation called by the Windows Socket Interface (Winsock) 
isn’t supported in this release of the software. Verify that you’re using a 
tested and supported release of Winsock and that it has been configured 
correctly.

“Cannot assign requested address.”
The requested address from the Windows Socket Interface is already 
being used. Check for background processes or other network applications 
that might be using up all available addresses. Also check for memory 
conflicts.

“Address already in use.”

The requested TCP/IP address isn’t available. Check your network 
software’s hosts file for proper configuration. Also verify that your defined 
network configuration matches your network cabling. If applicable, verify 
that the correct gateway and router information have been entered.
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“Network is down.”
The network isn’t accessible. Check with your system administrator to see 
if the network is operational. If it is, check your cabling and network card 
to make sure everything is connected properly. Try pinging yourself as 
well as a host. Also check for memory conflicts with interrupts or in 
extended memory.

“Network unreachable.”

The network cannot be reached from your PC. Possible reasons are: (1) 
There is a problem with your network software configuration; (2) The 
network is down or improperly terminated; (3) Your network card is 
malfunctioning. If you have eliminated these possibilities, check for 
bridges and routers as well as name information services, since these 
could also prevent you from making connections to the network.

“Network dropped connection on reset.”
The network has been reset since you started to make a connection. Try 
the connection again. If the error persists, check your hardware and 
cabling to verify proper operation. Also check for memory address conflicts 
within Microsoft Windows. (See your system administrator for assistance.)

“Software caused connection abort.”

The network connection was aborted by the server, due to a problem 
establishing or maintaining a network connection. Check your 
configuration files and verify that there are no memory conflicts in your 
system. Check your network hardware for proper operation.

“Connection reset by peer.”
The network connection has been reset since you started to make a 
connection. If this error continues, check your hardware and cabling to 
verify proper operation. Also check for memory address conflicts within 
Microsoft Windows. X program errors can also cause this failure; start the 
X Log File Browser to check for any hints of trouble.

“No buffer space available.”

There are no available buffers or TCP connections. This error usually 
occurs because there is only one TCP socket open and configured. If the 
network package you’re using has configurable buffer sizes, you might 
need to increase the buffer size to facilitate a connection.

“No buffer space available or no more available connections.”
A network connection cannot be established. Another network package 
might be running or you might be trying to use XDM and standard 
program startup at the same time. Verify that the network is operational. 
If possible, check your Display Management configuration to make sure 
you aren’t inadvertently using XDM.
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“Cannot send after socket shutdown.”
The network has been shut down. Contact your system administrator to 
verify this. If the network is actually operational, verify that your 
hardware and cabling are functioning properly. This error can also occur if 
an X program attempts to send information to a specific socket that has 
been closed.

“Too many references. Cannot splice.”

There were too many retries on a network connection. This typically 
occurs with XDM connections that are unable to connect to the server. 
Start the X Log File Browser to check for additional information.

“Connection timed out.”
The connection to the network timed out, resetting your request. Check 
your hardware to make sure it’s operational. Check for memory address 
and interrupt conflicts with the network card and network software. 
Contact your system administrator to verify the proper operation of the 
network. With some login methods, this error might be caused by heavy 
network traffic; try different login methods.

“Connection refused.”

The requested network connection has been refused. Make sure that 
you’re configured for the correct network type. Be sure the network is 
operational. Verify that there are no memory conflicts with Microsoft 
Windows. Verify that the host is online and that the login method you’re 
using is supported by the host.

“Host is down.”
The host you’re trying to reach is unavailable. Find out if the host is 
operational. If it is, check for an improperly functioning network card. Try 
pinging yourself and the host to get additional information.

“No route to host.”

The network software cannot reach the host. Check the hosts file on your 
PC for an incorrect or missing entry for the host, and check the /etc/hosts 
file on the host for an entry corresponding to your PC. Also check for 
memory conflicts, which might prevent the network software from reading 
the hosts file.

If the problem persists, try pinging the host.

If this error occurs during program startup, try a different startup 
method, in case the method you used was too fast for the host.
93



Troubleshooting
Program startup troubleshooting
If you try to start an X program and an error immediately appears in a 
message box, you might be experiencing the same kind of error that can 
occur during server startup. Locate the error message under the Server 
troubleshooting section to resolve the problem.

Otherwise, select the program entry from the X Server Control Panel and 
enable the Show Status Window and Show Response Window options. 
Click Run to start the program. If a message now appears in the 
connection response window, see the Connection Response Window 
messages section to resolve the problem. If no message appears, or if you 
can’t otherwise resolve the problem, see ”X program troubleshooting” on 
page 99.

Connection Response Window messages

“Cannot open display.”
Either the remote host cannot access the display specified in your startup 
command, or there are no available sockets left to connect to.

First, check the command line for misspellings or incorrect data. It’s best 
to use the whole startup command when starting X programs in a shell 
environment you’re not sure of. For example, to start an xterm on a PC 
named my_pc, the command line should read:

xterm -display my_pc:0 &. 

The X Server supports the local variable $DISPLAY in the X program 
command string. You may substitute $DISPLAY for your PC’s Internet 
name or address. The X Server automatically inserts the correct network 
information for your local PC. The command line could then read: 

xterm -display $DISPLAY &.

If your startup command is correct, there might be no TCP sockets 
available to connect to. Check your network configuration for the number 
of TCP sockets available.

If you’re already running an xterm, you can run the host program 
netstat to determine the number of sockets in use. The startup syntax is:

netstat -a | grep my_pc

This lists all the sockets being used by the computer my_pc; count them to 
find out how many sockets you’re using. If you’re at your limit, shut down 
one or more X programs before starting a new program.
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“Cannot open display on server ‘null’.”
You probably don’t have any TCP sockets available. See the previous 
message.

“Command not found.”
First, check the spelling of your login command. Any misspelling or 
incorrect case usage (such as x11 instead of X11) causes this error.

If the command is correct, your .cshrc or .login file might not include a 
path to the specified X program. Specify the full path (e.g., /usr/bin/X11/
xterm) in your startup command, or edit a login file to include the 
required path (see your system administrator for assistance).

If you don’t know the path to an X program, find a PC that’s properly 
connected to a host and try the which or whereis commands (for 
example, which xterm or whereis xterm). The response should be 
similar to this: /usr/bin/X11/xterm. (Note that these commands locate 
program files only, not script files.)

“ld.so: Library libXaw.so.4 not found.”
You need to set the environment variables for Sun OpenWindows in your 
login script file. Below are samples for the C shell and Bourne shell. 
(Default software locations have been assumed; make appropriate path 
changes based on your installation.) Consult your system administrator 
for assistance.

• C Shell—Add the following lines to the .cshrc file in your home folder:

setenv OPENWINHOME/home/openwin
setenv LD_LIBRARY_PATH $OPENWINHOME/lib:/usr/lib

• Bourne Shell—Add the following lines to the .profile file in your home 
folder:

OPENWINHOME=/home/openwin
export OPENWINHOME
LD_LIBRARY_PATH=$OPENWINHOME/lib:/usr/lib
export LD_LIBRARY_PATH

“X Error of failed request . . . .”
X errors typically relate to unavailable resources, such as fonts or colors.

A typical font-related X error might begin as follows:

X Error of failed request: weP
Major opcode of failed request: 45 (X_OpenFont)
Minor opcode of failed request: 0...
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This indicates that the X program you started could not find or open a 
requested font. The log file (start the X Log File Browser) should contain 
more information, such as “doOpenFont: read failed on file timrB14.” This 
example indicates a problem with a font called timrB14. In this case, you 
would need to create an alias for this font or find the .BDF or .PCF format 
file associated with it and compile it for use with SmarTerm’s X Server. 
(Use the Font Manager to do this; see the Font Management chapter 
starting on page 51.)

A typical color-related X error might begin as follows:

X Error of failed request: BadAccess
Major opcode of failed request: 89 (X_StoreColors)
Serial number of failed request: 17...

Other typical color-related X errors include X_AllocColor, X_LookupColor, 
and X_QueryColor. Such X errors typically have three sources:

• The X program requires TrueColor, but your configuration doesn’t 
support this mode. If your video card supports TrueColor, check your 
Windows setup to see if you’re using a TrueColor driver (Windows 
Control Panel>Display icon>Settings tab). If you are, verify that the X 
Server is configured to use TrueColor as your screen visual. To do so, 
select Options>Configuration in the X Server Control Panel, click the 
Graphics tab, and select the Screen Visual option.

• The program might be requesting more colors than are available. From 
the X Server Control Panel, select Options>Configuration, click the 
Graphics tab, select the Report 256 Colors option, and change its value 
to On. Click OK and a message appears indicating a server restart is 
required. Click Yes, then try starting your X program again.

If the program still won’t run, make sure you’re using a 256-color video 
driver (Windows Control Panel>Display icon>Settings tab).

• The X Server might be configured to use the wrong screen visual. To 
check this, select Options>Configuration from the X Server Control 
Panel, click the Graphics tab, and select the Screen Visual option. 
PseudoColor is usually the best choice.

Other X errors can stem from a variety of sources. Contact Technical 
Support for further assistance.

General X program startup troubleshooting
Start the X Log File Browser in the SmarTerm program folder to check for 
information. Proceed through the following steps until your problem is 
resolved. Contact Technical Support for further assistance.
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1. Ping from a Windows DOS prompt.
Open a DOS window from within Windows and try to ping a host. If this 
fails, there is probably a conflict between Windows and your network 
software. (Consult your network card vendor or documentation for the 
starting memory location and size requirements.)

2. Try several startup methods.
Each startup method uses a different means to connect to a host. Some 
methods provide long, detailed error messages in the connection response 
window, while others might return none at all. If you do receive a message, 
see ”Connection Response Window messages” on page 94 to identify the 
error.

3. Specify complete path to the X program.
X programs can be located anywhere on a host system. If your login 
environment is incomplete or incorrect, your startup command needs to 
specify the entire path to the program. As a rule, most X programs are 
stored in a folder called /usr/bin/X11, but this location depends on the 
system (for example, on Sun systems xterm is stored in /usr/openwin/
bin). 

See information under “Command not found” on page 95 for more details.

4. Check TCP sockets.
TCP sockets are controlled by the network software. Check your network 
configuration to make sure that at least six TCP sockets are available.

The X Server uses two TCP sockets, and each X window requires one 
socket. If you use an X program to spawn additional applications, each of 
these requires a socket as well.

5. Check display name.
To start an X program process, a host must know which display to direct 
its video output to. Make sure your startup command includes the correct 
display name (corresponding to the network name of your PC). Check also 
that this name is included in the /etc/hosts file on the host system.
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6. Try starting a simple X program.
Some X programs are more complicated than others, and thus might have 
a harder time starting. If you cannot run a particular X program but are 
able to run a simple program (such as xbiff, xclock, xload, xeyes, or 
xlogo), you can assume that the more complicated program is the source 
of the problem. Contact your system administrator or Technical Support 
for further assistance.

7. Start an X program from another computer.
Launch the X Server on your PC. From another computer (one that’s 
operating correctly), log on to the host. Start an X program from the host 
prompt, directing the output to your PC by specifying its name as the 
display variable.

If the program appears on your PC, there is probably a problem with the 
startup method you’re using. If the program doesn’t appear on your PC, 
there is probably a problem with your PC’s network software or with the 
host system’s /etc/hosts file.

8. Try using another REXEC, Rlogin, RSH, or Telnet utility.
If the X Server cannot start an X program using one or more of these 
startup methods, the host MIGHT not allow the methods you’re using. Try 
using another startup method.

REXEC, RSH, and Rlogin all require a file on the host that identifies your 
workstation and allows it access. Contact your system administrator for 
details.

9. Try a different login account or host.
Some user accounts might have odd items in their login files (.cshrc, 
.login, .profile, .kshrc, .Xdefaults, or .xsession). You can either 
comment out all the commands in these files or try a different user 
account to see if the problem goes away. Also try logging in to a different 
host to see if you get the same results.

10. Check the nohup.out file.
Use the nohup (no hang-up) command as the first argument in your 
startup command. This command keeps the network connection open even 
after the startup command terminates. If a startup error occurs, it’s stored 
in the user’s home folder in a file called nohup.out. Open this file from 
another host connection on your PC or from another system to get 
additional information.
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11. If you are using XDM, check the xdm-errors file.
If an XDM startup attempt fails, check the xdm-errors file, usually 
located in the /usr/lib/X11/xdm folder, for more information.

12. Redirect errors to a file.
In some cases an error returned from an X program can disrupt its 
startup. To avoid such conflicts, you can redirect errors to a file.

On a Sun host, the C shell redirection syntax is as follows: 

xterm -display pc_name:0 & >/dev/null &. 

The syntax might be slightly different for other hosts or shells.

13. Use a startup command to create a file on the host.
Sometimes a startup command never reaches the host. You can verify that 
commands are reaching the host by specifying that a file be created. If the 
file appears on the host, the connection is fine and there is something 
wrong with the original command or with the redirection of the program 
you’re trying to run. If the file isn’t created, there is a problem with the PC 
network software, the host network, or the login method.

To create a file on the host, use the following startup command: /bin/ls > /
home_account/testfile, where home_account specifies your home folder 
and /bin is the path to the ls program. This creates a file called testfile in 
your home folder.

X program troubleshooting
This section provides troubleshooting for situations in which you’re able to 
start an X program but encounter some difficulty once the program is 
running.

Backspace key does not work within an X program.
At the host prompt, enter the following:

stty erase ^h

where ^h is the result of typing Ctrl+H. You can also enter this in a login 
script (if you’re using vi, type Ctrl+V before typing Ctrl+H).
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Cannot launch additional programs from within an X program.
Diagnostic information usually appears within the originating X program. 
This is often similar to information you would have seen in the connection 
response window had you run the program from the Control Panel. See 
”Connection Response Window messages” on page 94 for troubleshooting 
procedures. 

Geometry specification for an X program does not work.
Disable the Cascade Windows option (accessed by selecting 
Options>Display from the X Server Control Panel). When enabled, this 
option causes Microsoft Windows to determine the position of new 
windows, overriding the X program geometry specification.

Some Sun OpenWindows applications will not run.
Certain Sun OpenWindows programs, such as News Reader, Image Tool, 
and Answer Book, don’t run on a non-Sun workstation or with a PC X 
server like SmarTerm’s X Server. This is because these programs require 
Display PostScript to operate. Display PostScript is part of the Sun X 
Window System but not part of the standard (X11R6) X Window System.

If you’re having problems starting an X program from a Sun system, check 
with your Sun support representative to determine if the application 
requires Display PostScript to operate.
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active The currently selected icon or window. Keyboard or mouse actions are 
directed to the active window or icon.

AIX Advanced Interactive Executive, IBM’s implementation of UNIX.

ANSI American National Standards Institute, the group responsible for 
implementing computer standards in the U.S.

application A software program, such as the SmarTerm X Server. X applications are 
often called clients. 

application icon A graphic that appears on your desktop after you start an application and 
then minimize it. 

application window A window that contains an application that is running. 

atom A unique numeric identifier associated with a string name. An atom is 
used in X to identify a selection, type, or property. 

background Each window can have a background that is defined as a pixmap. 

backing store A feature in X that allows the server to save occluded window areas off-
screen and return them, without client interaction, when the window is 
uncovered. 

bit Basic unit of computer information. A bit can have one of two values: 0 or 
1; on or off; true or false. 

bitmap A memory area that represents an array of pixels. 

bitplane A bitmap of pixel depth 1. 

border The area of equal thickness surrounding a window on all sides. 

check box A small square that appears in a dialog box, indicating that an option can 
be selected or cleared. When an option is selected, an X appears in its 
check box.
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choose To select an item or command by clicking on it or by using the appropriate 
key sequence. 

class A general group to which a specific X object belongs. 

click To quickly press and release the mouse button. 

client An application that runs under X. The window manager is also a client. 

clipboard A temporary storage area for text and graphics transferred between 
windows. 

clipping region A rectangle used to restrict output to a specific region of a window. 

CMRS™ Color Map Reservation System, X Server’s ability to protect 18 of the 20 
static colors of the default palette. This protects the ability of Microsoft 
Windows to match color requests. 

connection The establishment of a communication path between the server and client 
program. 

cursor The visible shape of the pointer on the screen (often an arrow, but many 
shapes are supplied). 

cut To move an item from a document and put it into the Clipboard. 

desktop The screen on a display of a graphical computer interface. Usually 
includes icons, menus, and windows. 

desktop manager An X client that gives users the means to perform high-level manipulation 
of operating system functions. 

dialog A box that appears in response to a menu command to provide or request 
information. 

direction keys Keys marked with arrows used to move the cursor up, down, left, and 
right. 

double-click To click the mouse button twice in rapid succession. 

drag To hold down the mouse button while moving the mouse. 

ethernet A high-speed LAN technology capable of transfer rates up to 100 million 
bits per second (mbps). 

event A message that informs a client of input or the effect of a request. 

expose event An event sent to inform a client when the contents of a window have been 
lost and need to be redrawn. 

extension A functional enhancement to the core X protocol that extends the system. 
Examples of extensions are: output requests, resources, and event types. 
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font A collection of characters and displayable items such as cursors. In X, 
fonts are treated as bitmap arrays with additional metric information that 
determines spacing and other properties. 

frame The border that window managers typically put around windows. 

graphical user
interface (GUI)

A collection of graphical techniques and images that allows the user to 
control the computer. GUIs have varying appearances and interactivity 
techniques. GUIs are also referred to as the “look and feel” of a product.

highlighted Selected, as said of objects or text. Highlighted items appear in reverse 
video on monochrome displays and in color on most color displays. 

hint A property associated with an X window that may be acted upon or 
ignored by the window manager. 

host A physical computer and operating system upon which an X client runs. 

icon A graphic representation for various elements, such as application 
programs. 

input-only A window that cannot be used for graphics output requests. 

window Input-only windows are invisible and control cursors, input event 
generation, and other features. They cannot have windows as inferiors. 

interprocess
communication (IPC)

A communication path (such as TCP or a shared memory buffer) between 
processes.

ISO International Standards Organization, a group founded in 1975 to create 
worldwide standards for the computer industry. 

local area network
(LAN)

A network that functions within the confines of one site or building.

mapping The process by which a client makes a window eligible for display. 

maximize To expand a window to its maximum size, which is determined by the 
application running in the window. 

minimize To reduce a window to an icon without closing the application. 

Motif A graphical user interface specification and toolkit for X offered by the 
Open Software Foundation. 

Motif Window Manager
(MWM)

The window manager that adheres to the Motif look and feel. MWM was 
developed by the Open Software Foundation and is noted for its 3D 
appearance.

multiple-window mode A display mode in which SmarTerm’s X Server opens an individual 
Microsoft Windows window for each client. 

network Several computers connected together with the aid of special hardware 
and software rather than simple serial connections. 
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network file server
(NFS)

A network file communication protocol developed by Sun Microsystems.

obscured Partially viewable. A window is obscured if it is only partially visible 
because another window or object is in front of it. 

occluded Not viewable. A window is occluded if it is completely covered by another 
window or object. 

operating system A program that controls the operation of computer hardware and presents 
an interface through which the user can work with application programs. 

overlapping windows Windows that are placed on the screen so that each window covers part of 
another. Overlapping is the opposite of tiled.

parent window A new window created with reference to an existing window. 

passive A method of starting a client in which the server is initialized with all 
configuration files loaded, but the client is started from another host on 
the network. 

paste To transfer the contents of the Clipboard into an application. 

path name A description of the location of a folder or file. The path name’s entries are 
separated by slashes. Backslashes are used in DOS and forward slashes 
are used in UNIX. 

pixel The smallest graphic unit on the display screen. 

pixmap A two-dimensional array of pixels. 

point size A unit of measure for a font. One point is equal to 1/72 of an inch. 

pointer The device attached to the cursor and tracked on the screen. 

program In SmarTerm X Server, the name under which all the program properties 
(host name, connection method, user name, password, etc.) to connect to X 
programs are saved.

property An object associated with an X window that has a name, type, data 
format, and some data. Properties are used for storing data and 
communicating between clients. 

reply The server’s response to an information request from a client. 

request A command to the server from a client. 

resource General term for windows, pixmaps, cursors, fonts, graphic contexts, etc.

rexec A client startup method in which the server is initialized with all of the 
configuration files loaded. The rexec program executes a program on a 
remote machine that connects to the X server. 
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root window The window that covers the background of the entire screen. All other 
windows are displayed on the root window. 

rsh A client startup method in which rsh (remote shell) executes a program on 
a remote machine that connects to the X server. 

save under A technique of saving the image on the screen under a window so that the 
image can be restored when the window is moved on the display or 
removed from the display. 

screen The display area of a monitor. 

scroll bars The bars at the bottom and right edge of a window whose contents are not 
entirely visible. 

select To highlight an item by clicking on it. 

server The program that serves as an interface between the display and the 
client programs. The SmarTerm X Server allows a computer capable of 
running Microsoft Windows to be used as an X display. 

single-window mode A display mode in which the X Server opens one Microsoft Windows 
window, which is then accessed like an X root window. All X clients are 
displayed in this single window. An X window manager must be invoked to 
manipulate X clients in the window. 

TCP/IP Transmission Control Protocol/Internet Protocol, a communications 
protocol used in networks that follows the U.S. Department of Defense 
standards. Commonly used on Ethernet between technical UNIX 
workstations, X terminals, and X PCs. 

telnet A client startup method in which users can start an X application by 
remotely logging on to any machine on a network on which they have an 
account.

tiled windows Windows that lie vertically or horizontally adjacent to each other on the 
screen, with no window covering any part of another. Tiled is the opposite 
of overlapping. 

UNIX A multi-tasking operating system originally developed by AT&T. 

vector A line or line segment. 

VEX Video Extensions to X, a proposal for including video capabilities in the X 
protocol. 

virtual screen A display option, available in single-window mode, that lets you create a 
virtual screen of up to 32K  32K pixels for the X server application. 

visible A region of a window that is viewable and not occluded on the screen by 
the user. 

wide area network A network that may span several sites or buildings. 
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window manager A special application program that allows the user to perform common 
window system functions, such as opening, closing, moving, and resizing 
windows. 

X protocol The protocol used for communication between X clients and the server. 
The protocol is the same whether the client and server are running on the 
same system or on different computers linked by a network. 

X server The program that provides the basic windowing mechanism for X 
applications. 

X terminal A combination of hardware and software specifically designed to run the X 
Window System server. 

X Window System The graphics protocol developed by MIT that enables applications to run 
in a server-based, object-oriented, windowed environment. 

XDM Broadcast A startup method in which the X server sends a request to all hosts on the 
network. The hosts that do not wish to service the request ignore the 
broadcast. 

XDM Direct A startup method in which the X server sends a request to the X Display 
Manager program running on a specific host. 

XDM Indirect A startup method in which the X server sends a request to a single host, 
expecting that the request is forwarded to a larger collection of secondary 
managers on different hosts. The first secondary host to respond launchs 
the initial clients. The initial host may also accept the request. 

XDMCP X Display Manager Control Protocol. Allows a network administrator to 
manage X terminal and workstations from a single host. 
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(MWM) Motif Window Manager, 103

A
AIX, 101
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atom, 101

B
backing store, 101
backspace errors, 99
BDF fonts, 51, 52, 54
bitplane, 101
browser X clients, 65
buffer space errors, 92
build FONTS.DIR command, 56

C
cascade windows, 34
cascade X, 34
class, 102
client, 102
client startup troubleshooting, 94
client troubleshooting, 99
clipping region, 102
color, 79

palettes, 81
support, 79

color conventions
keymap editor, 70

color cursor
modifying, 84

Color Map Reservation System (CMRS), 
83

color name database, 80
color support, 79

adding a color, 85
and Microsoft Windows, 81
and SmarTerm X, 82

deleting a color, 86
RGB editor, 85
searching for a color, 86

colorcells, 79, 80, 82
colormaps, 79, 82

virtual, 80
components, of SmarTerm X, 14
configuration dialog, 37
configuration options, 31

accessing, 31
connection data, 19
connection errors, 92, 93, 94
connection response window

messages, 94
control panel, 6

elements, 6–11
menu bar, 7
program startup area, 11
toolbar, 10

copy X area, 13
cursor color, modifying, 84
cut and paste, 13

D
database files

fonts, 57
default palette, 81
desktop manager, 102
direction keys, 102
display devices, 82
display, error opening, 94
documentation conventions, ix

E
edit font DB command, 56
edit X resource, 49
edit X Server, 13
enable/disable root window, X Server, 14
errors

network-related, 87

winsock, 91
event, 102
examples

program entries, 25–29
expose event, 102

F
FON fonts, 51, 54
font

error messages, 89
server, 51, 52

font manager, 54
commands, 55
defined, 14

font substitution, 58
fonts

adding, 57
aliases, 57
BDF, 51, 52, 54
conversion, 54
database files, 57
deleting, 57
FON, 51, 54
management, 51
Microsoft Windows, 57
monospace, 52
PCF, 51, 52, 54
scaleable, 51, 52
Speedo, 52
Type 1, 52
X11R5, 51

fonts configuration tab, 44
FONTS.ALI file, 57, 89

G
general configuration tab, 47

edit X resource, 49
IPX/SPX name, 47
load local X resource, 48
local host access control, 48
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network type, 47
X Resource File, 48

general protection faults, 90
geometry specification, 100
graphics configuration tab, 41
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H
help menu, 10
hint, 103

I
icons, 10

control panel, 10
IM server, 15
installation requirements, 1
installing SmarTerm X, 1
interprocess communication (IPC), 103
IPX/SPX name, 47

K
keyboard mapping. See keymap editor
keyboard preferences, 35
keymap editor, 69

accessing, 69
color conventions, 70
keysym groups, 71
macro, 73
map to compose, 75
modifier keys, 72
modifying a keymap, 70
other modifiers, 73
saving keymaps, 72
user defined keysysm, 73

keymap selection
program properties, 23

keysym groups, 71

L
load local X resource, 48
local host access control, 48
local resources, X Server, 13
Log, 77
log file, 77, 96
log file browser

defined, 15
launching, 77

Logical Font Description (LFD), 52, 56

M
macro,keymap editor, 73
map to compose, 75
match to closest Windows fonts, 58
memory resources, 89
menus, 7

help, 10
options, 8

program, 7
utilities, 9
view, 8

Microsoft Windows
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color support, 81
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fonts tool, 57
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modes
multiple-window mode options, 34
single-window mode options, 34

modifier keys, 72
monospace fonts, 52
Motif, 103
mouse panning, 34
mouse preferences, 36
multiple-window mode

cascade windows, 34
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fit window to display, 34
force window on screen, 34
mouse panning, 34

multiple-window mode options, 34

N
netstat client, 94
network

errors, 87, 92
traffic, 45, 46

network type, 47
network-related errors, 87
nohup.out file, 98

O
occluded, 104
options menu, 8

P
password

program properties, 20
PCF fonts, 51, 52, 54
performance configuration tab, 45
performance tuning application, 67
ping utility, 87, 93, 97
preallocate colors, 84
program entries

creating, 17
examples, 25–29

program information
entering, 18

program menu, 7
program properties

connection data, 19
custom startup data, 22
keymap selection, 23
password, 20
testing, 24

XDM, 20
program properties dialog, 18
program startup, 17
program startup area, 11
protocol collection, trace, 61
protocol filter,trace, 61
PseudoColor, 43, 82, 83

R
reconfigure utility, 15
reserve system colors, 83
rexec, 104
RGB color model, 79
RGB editor, 85
RGB.TXT file, 41, 88, 89
root window, 105

resolution, 39
running setup, 3

S
saving keymaps, 72
scaleable fonts, 51, 52
screen visuals, 80, 82
server configuration tab, 39
server troubleshooting, 87
setup, 3
single-window mode options, 34

mouse panning, 35
scroll bars, 35

SmarTerm X
color support, 82
described, 5
installation, 1
uninstalling, 15

Speedo fonts, 52
starting X Server, 11
startup data, 22
StaticColor, 43, 82, 83
StaticGray, 43, 82, 83
Sun OpenWindows, 95

applications, troubleshooting, 100
support, x
system palette

Windows, 81

T
TCP sockets, 97
technical support, x
testing a program entry, 24
toobar, 10
trace

initiating, 64
protocol collection, 61
protocol filter, 61
setting up, 60
translated output file name, 63
translating and viewing output, 64
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troubleshooting
client, 99
client startup, 94
server, 87

TrueColor, 43, 82
Type 1 fonts, 52

U
uninstalling SmarTerm X, 15
upgrading from a previous version, 2
user defined keysym

keymap editor, 73

utilities menu, 9

V
view menu, 8
virtual colormaps, 80

W
web browser X clients, 65
web enabled X, 65
window configuration tab, 37
window management dialog, 32
window mode, 33

options, 34
Windows Socket Interface, 91
winsock error messages, 91
wire frame cut & paste, 13

X
X clients

web enabled X, 65
X errors, 95
X protocol communication, 59
X protocol trace, 59

defined, 14

X Resource File, 48
X Server

defined, 5
edit, 13
enable/disable root window, 14
launching, 11
local resources, 13
main menu, 12
performance tuning application, 67
uses, 11

X Window System, 5
Clipboard, 39
color support, 79
fonts, 54

X11R5
font server, 51, 52
fonts, 51

XDM, 20, 67
XDM broadcast, 106
XDM Direct, 106
XDM Indirect, 106
XDMCP, 106
XDMCP errors, 99
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fonts, 52
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